
Traditional Data Entry Training 

Data entry training might be crucial for your landing a data entry job. Because you Understand the job 

tasks that are required in many outsourced data-entry jobs. 

 
The purpose of data entry training is to develop the necessary skills to allow you to effectively do your 

job with little or no problem. In order for this happen, two things needs to be implemented: the trainer 

must seek to make all the information clear enough that the trainee can understand it and the trainee 
must give the trainer total, undivided attention. 

 
What Kind of Training Will You Need? 

Data entry training must incorporate tools to help you work with speed, work with accuracy, and methods 
to help you tune out distractions so concentration will never be affected. (Poor concentration makes 

speed and accuracy difficult.)  

 
WORD PROCESSOR 

The most important tool you will need to learn is using a word processor. In this training we will not only 
give you a free word processor, but we will also give you complete training on how to use the word 

processor for many different types of data-entry assignments you will be doing. 

 
How Do You Strengthen Your Skills? 

In order to develop these traits, the data entry training must provide specific drills to help you properly 
develop the traits. If this is lacking, the training will not produce proper data entry workers. We also will 

have you use our typing tutor, which can increase your typing speed and accuracy.  

 
You can access that HERE at anytime, or from our members' home page. 

 
Now, the best data entry training in the world will not work if the trainee is not paying strict attention and 

is not willing to learn this new skill. If these are present, they will make the data entry training successful, 
allowing you to have a fruitful career. 

 

We are going to give you the training in the basics of data entry and in how to use the applications we 
will provide. 

 

What is Data Entry? 
Data entry is "the process of entering data into a computerized database or spreadsheet. Data entry can 

be performed by an individual typing at a keyboard or by a machine entering data electronically." 
 

That is the official definition according to Webopedia. It is a simple process of entering words and 
graphics in particular formats using special software. It comes down to this: if you can type, you can do 

data entry as we will show you in this training. 

 

Nature of the Work 
The U.S. Department of Labor's Bureau Labor Statistics reminds us that "Organizations need to process a 
rapidly growing amount of information. Data entry and information processing workers help ensure the 

smooth and efficient handling of information. By keying in text, entering data into a computer, and 

performing other clerical duties, these workers help organizations keep up with the rapid changes that 
are characteristic of today’s Information Age. In addition to the job titles... such as word processors, 

typists, and data entry keyers—data entry and information processing workers are known by various 
other titles, including electronic data processors, keypunch technicians, and transcribers."  

 
Employment 

http://keybr.com/


The BLS goes on to say that data entry and information processing workers held about 725,000 jobs in 

2010 and were employed in every sector of the economy; 430,000 were data entry keyers and 295,000 
were word processors. Many workers telecommute, working from their homes on personal computers 

which is then linked to those in the main office. This arrangement enables them to key in material at 
home while still being able to produce printed copy in their offices. 

 

Overall employment of in-office data entry and information processing workers is projected to decline 
through 2014. Why? Although word processors, typists, and data entry keyers are all affected by 

productivity gains stemming from organizational restructuring and the implementation of new 
technologies, projected growth differs among these workers. Employment of word processors and typists 

is expected to decline because of the proliferation of personal computers, which allows other workers to 
perform duties formerly assigned to word processors and typists... Moreover, as telecommunications 

technology improves, many organizations will increasingly take advantage of computer networks that 

allow data to be transmitted electronically... These networks will permit more data to be entered 
automatically into computers, reducing the demand for in-office data entry keyers. 

 
Simply put, with the popularity of home computers, Internet connection, and basic word processing 

knowledge, the in-office worker will decline, as the work-from-home data processor will increase. 

You will be able to take advantage of this opportunity. 
 

We will list the most current jobs, and assignments where you might use your new data entry skills, after 
you have completed the training course we provide. 

 

Earnings 
How much can a work-from-home word processor make? 

Median annual earnings of work-from-home word processors and typists in May 2010 were $30,030. The 
middle 50 percent earned between $23,850 and $35,900. The lowest 10 percent earned less than 

$19,960, while the highest 10 percent earned more than $46,190. The salaries of these workers vary by 

industry and by region. Many home typist do not spend more then 4 hours per days, 5 days a week 
working from home. If you were to work more hours per day you would make more money. Expect on a 

beginner level to make $10 per hour, and on an advance level about $18-$20+ per hour. 
 

Training Outline 

We are going to break the training down into sections. We will start off by explaining the different types 
of data entry projects, the equipment and software needed, and then focus on the most popular types of 

data entry, and training you in these popular types of data entry formats. Our goal is to get you a 
complete understanding of what word processing is, and how to use the software designed to perform 

the assignments. As we do this we will also teach you the popular terminology that you will need to know 

for better understanding this work. 

 
 

Our training program cirriculum: 

 
1. The Types of Assignments for Data Operators 

2. The Types of Data Entry our Program Teaches 

3. Equipment and Software Needed to be a Data Operator 
4. Introduction to Your Word Processor 

5. How to Use Your Word Processor 
6. Basic Rules and Tips on Using Word Processor 



7. Practice and Quiz 

8. Data-Entry Jobs & Assignments 
 

 

1. The Types of Assignments for Data Operators 
Data entry covers many different avenues, from simple word processing of textual documents to detailed 

charts and spreadsheets.  
 

Here are the types of work that would fall under the job descriptions of a data entry operator: 

Here are the type of work you can pertorm as a data-entry operator 

 WORD PROCESSING 
 LETTERS, REPORTS, JOURNALS 
 MANUSCRIPTS, NOVELS, NON-

FICTION 
 DISSERTATIONS, THESES 
 PROOF READING, INDEXING 
 COPY EDITING (LIGHT & 

SUBSTANTIVE)  
 COPY WRITING 
 MAILSHOTS (SNAIL MAIL, EMAIL, 

FAX), LABELS 
 POWERPOINT PRESENTATIONS 
 DESKTOP PUBLISHING 
 NEWSLETTERS, BROCHURES 
 DATA ENTY KEYING 
 VIRTUAL OFFICE MANAGEMENT 
 TERM PAPERS 
 ACADEMIC ESSAYS 
 LECTURES, SPEECHES 
 AUDIO TYPING TAPE 

TRANSCRIPTION 
 MINI OR MICRO CASSETTES 
 STANDARD AUDIO TAPES 

 DIGITAL DICTATION 
 VIDEO & MINI DISC 

TRANSCRIBING 
 CONFERENCE PROCEEDINGS 
 RESEARCH INTERVIEW 

TRANSCRIPTION 
 OVERHEADS / SLIDE 

PRESENTATIONS 
 CVS / RESUMES 
 MINUTES 
 INVOICES / STATEMENTS 
 E-MAILS, FAXES 
 BOOK-KEEPING, VAT 
 MEETINGS, EVENT PLANNING 
 DOCUMENT / PHOTO SCANNING 
 RESEARCH 
 SPREADSHEETS 
 DATABASES, DATA PROCESSING 
 DOCUMENT FORMATTING 

 

2. The Types of Data Entry Our Program Teaches 
When you look at the list of data entry types above, it seems like a lot to learn; it really isn't. We are 

going to concentrate on two types of data entry: word processing, and data entry keying. Learning these 

two types of data entry will cover about 80% of the outsource types of data entry work you will receive 
(excluding transcription, which we teach you in a separate program). The only types we will not cover will 

be, proofreading, copy editing, and bookkeeping, because these take additional skills and education. The 
following jobs are usually done on site and will not require telecommuting assistance: PowerPoint 

presentations (to a certain degree), overhead slide presentations, conference proceedings, and 

document/photo scanning. 

What does word processing mean? 

"A program designed to create, edit and print text based documents including: letters, memos, faxes, and 

reports etc. A word processor enables you to save your documents on the computer and edit and update 



them later." 

 
Here is a slightly longer definition:  

"Using a computer to create, edit, and print documents. Of all computer applications, word processing is 
the most common. To perform word processing, you need a computer, a special program called a word 

processor, and a printer. A word processor enables you to create a document, store it electronically on a 
disk, display it on a screen, modify it by entering commands and characters from the keyboard, and print 

it on a printer. The great advantage of word processing over using a typewriter is that you can make 
changes without retyping the entire document. If you make a typing mistake, you simply back up the 

cursor and correct your mistake. If you want to delete a paragraph, you simply remove it, without leaving 

a trace. It is equally easy to insert a word, sentence, or paragraph in the middle of a document. Word 
processors also make it easy to move sections of text from one place to another within a document, or 

between documents. When you have made all the changes you want, you can send the file to a printer to 
get a hard copy." 

 
You all already doing data processing in a certain manner now, and may not even realize it. We are just 

going to expand on the basics you already know. 

And you would be the word processor! 
Word processors usually set up and prepare reports, letters, mailing labels, newsletters, and other text 

material. As a entry-level work-from-home worker, you may begin by keying headings on form letters, 
addressing envelopes, or preparing standard forms on computers. As you gain experience, you often are 

assigned tasks requiring a higher degree of accuracy and independent judgment. Senior word processors 

may work with highly technical material, plan and key complicated statistical tables, combine and 
rearrange materials from different sources, or prepare master copies.  

All keyboarding is now done on computers that normally are connected to a monitor, keyboard, and 
printer. Word processors use this equipment to record, edit, store, and revise letters, memos, reports, 

statistical tables, forms, and other printed materials.  

Expansion of work possibilities 
In addition to fulfilling the duties mentioned above, word processors often perform other office tasks, 

such as virtual office assistant work. You work-from-home setting up appointments, scheduling and other 

tasks for office executives. 

Data entry keyers usually input lists of items, numbers, or other data into computers or complete 
forms that appear on a computer screen. They also may manipulate existing data, edit current 

information, or proofread new entries into a database for accuracy. Some examples of data sources 

include customers’ personal information, medical records, and membership lists. Usually, this information 
is used internally by a company and may be reformatted before other departments or customers utilize it. 

Keyers use various types of equipment to enter data such as personal computers. Increasingly, data 

entry keyers are working with non-keyboard forms of data entry, such as scanners and electronically 

transmitted files. 
 

Difference between a Word Processor and a Data Entry Keyer 
A simple way to describe the differences between a word processor and a data entry keyer may be this; a 

word processor will be more creative, using your own creative skills in many cases to create documents. 

A word processor will use processing software such as Microsoft Word's creative abilities to create 
documents as input by the processor (you).  

 



A data entry keyer's job will be less creative, usually simply inputting data in simple format from a 

described preset document. A data entry keyer will usually get text that can be as simple as a note pad, 
and input that into the computer. It will be a more repetitious job task that is very simple and usually 

does not require any creativity. 
 

Here is a good example of the difference between a word processor and a data entry keyer. As a word 

processor you may get an assignment to create fax cover sheets for everyone in a corporate office, you 
will receive the names, titles and the fax numbers of all the persons in need of these fax cover sheets.  

 
Here is what the assignment sheet may look like: 

 
Assignment Sheet 

Don Williams - President Fax#  210-555-1200  210-555-1200  

Alice Roberts - Vice President Fax#  210-555-1201  210-555-1201  

Laura Plant - Executive V.P Fax#  210-555-1202  210-555-1202  

Horace James - General Mgr. Fax#  210-555-1203  210-555-1203  

Peter George - Asst. G.M Fax#  210-555-1204  210-555-1204  

Darryl Krause - Marketing Director Fax#  210-555-1205  210-555-1205  

Lisa Drake - Asst. Marketing Director Fax#  210-555-1206  210-555-1206  

Robin Dalby - Operations Mgr. Fax#  210-555-1207  210-555-1207  

Gordan Felton - Project Manager Fax#  210-555-1208  210-555-1208  

Tim Scott - Personal Relations Mgr. Fax#  210-555-1209  210-555-1209  

 
You then will be creative using your word processing software, such as Microsoft Word  or the word 

processor we will give you for free (OpenOffice) to create these fax cover sheets. An example is shown 
below. 

ABC Corporation 
Your Textile Specialist 

2253 West Main st. 

San Diego, CA 91206 

Phone#  1-800-555-5555  1-800-555-5555  

Main Fax 210-555-1199 

 

FAX COVER SHEET 

 

To:__________________________________________ 

 

 

Date:_________________________________________ 

 

 

Subject:_________________________________________ 

 

From: Don Williams - President  



Fax#  210-555-1200  210-555-1200  

Message:_________________________________________ 

_______________________________________________ 

______________________________________________ 

_______________________________________________ 

_______________________________________________ 

Respectfully Yours, 

Don Williams 

President 

As a WORD PROCESSOR you would have created this fax cover sheet, using creativity in choosing font 
sizes, colors, and properly spacing the margins, lines etc. as we will show exactly how to do in the Word 

processor training section below. 
 

As a DATA ENTRY KEYER - You would have typed up the Assignment Sheet with the names, titles and 
the fax numbers of all the persons from a sheet of paper, to GIVE to the word processor to make the fax 

cover sheets. A data entry keyer will tend to do more on the 10-key of your keyboard, because a data 
entry keyer does a lot of numerical data entry. 

 

So you see the difference in having to be creative (word processor) and not having to be to creative 
(data entry keyer).  

 
 

3. Equipment and Software Needed to be a Data Entry Operator 
There is not a lot of equipment or software that will be needed to become an entry level data entry 
operator. We will list the equipment and software that is absolutely needed, as well as some additional 

optional equipment and software that may be needed down the line. 

 

Computer - If you are taking this training, more then likely you already have your computer, keyboard, 
and mouse. You can use a laptop as well, as long as it has printer port capabilities and Internet access.  

 
Printer - A printer will be a must to do word processing, so you can print out your work in mass if 

required, as well as check your document before transmitting the file over the Internet. You can get 

printers for very cheap on eBay, at garage sales, or flea markets. A very good option is the HP 
OfficeJet All-in-One series. For under a hundred dollars (brand new), this printer will Print (Color/B&W), 

fax, scan and makes photo copies all in one unit. This is a great deal for what you get. 
 

Fax Machine - With the digital transmission ability on your computer (sending files 

electronically through e-mail) a fax machine is becoming a thing of the past. So don't worry if you you do 
not have the ability to send faxes through a phone line as probably more than 90% of the possible 

assignments will allow to be transmitted through e-mail or even regular snail mail. 
 

FREE ONLINE FAX SERVICE 
You can use a free service provided on the Internet that will allow you to send electronic faxes directly 

through their Web site. It is a great service that you can use if you are needing to fax a document. You 



can find out more about FAXZERO HERE  

 
Internet Connection - Not everyone will have access to high speed Internet, which will be okay. It is 

preferred, however, since this will help speed up transfers from the company outsourcing work to you; it 
will not be important to the actual work you will be performing. You will be doing most of your word 

processing assignments off line and will not need to be connected to the Internet while you are 

performing the work. It will be a plus to have a high-speed connection, but it will not be required for 
most of the assignments you can receive. 

 
Word Processing Software - Word processors are the workhorses of computers. Almost everyone has 

a word processing program of some sort sitting on his or her computer – whether it came free with your 
system or you picked it out specially. 

There are thousands of word processing programs for you to choose from, each offering a different mix 
of tools to help make it easier for you to write everything from letters and memos to brochures and Web 

pages. 
 

Your free word processor - 

If you're using Windows 95 and newer, you received a free word processor with your operating system: 
Windows Write with Windows 3.1 and WordPad with Windows 95 and newer. These programs are fine 

for basic editing tasks, allowing you to create documents with bolded or italicized text, for example, and 
change the typeface style and size. You will need more of a work horse of a word processor that will 

allow you to do most of the assignments, which we will go over here.   

Paid word processor software 

In 'works' style packages such as Microsoft Works or Claris Works, you'll find more sophisticated word 

processing programs packed with snazzy features and designed to make everyday word processing 
easier. Such packages are great for home and school usage, or anywhere with modest word processing 

needs. 

For those who need to create documents at work or who need to create complex documents (reports, 

theses, novels, graphics-intensive or table-intensive documents), a dedicated word processor from one of 
the big three – Corel, Lotus or Microsoft – will provide all the power you need. There are also word 

processors from many other companies, but you'll find a staggering percentage of the PC-based world 
uses Corel WordPerfect, Lotus Ami Pro (or the newer Word Pro), or Microsoft Word for Windows. 

 
Microsoft Word for Windows. - This is the most commonly used program on the planet for word 

processing, and we are going to give you a complete training on Microsoft Word.  

 
If you already have a Word 2000 or newer and know how to use it, you are in great shape and ready to 

get working. If you DON'T, we have some good news, and we have some bad news. Okay, the bad 
news first: to get a newer version of Microsoft Word, with all the goodies of Office, Excel and etc., will 

cost you in the neighborhood of $200. Now for the GOOD NEWS!, we are going to give you a download 

of OpenOffice (a Microsoft Word CLONE) for FREE! yes 100% free; this is not a trial, it is yours to 
keep. OpenOffice will have all the same features as Microsoft Word, without out the fancy "Microsoft" 

name. See, you already made $200 and have not even started work! 
  

We will give you complete training on OpenOffice as well. 
 

OpenOffice will accept donations: however, it is not required but is optional. 

http://faxzero.com/


 
FREE! Word Processor 

OpenOffice Features: 

 

Writer– a word processor you can use for anything from writing a quick 
letter to producing an entire book. 

 

Calc– a powerful spreadsheet with all the tools you need to calculate, 
analyze, and present your data in numerical reports or sizzling graphics. 

 

Impress– the fastest, most powerful way to create effective multimedia 
presentations. 

 

Draw– lets you produce everything from simple diagrams to dynamic 3D 
illustrations. 

 

Base– lets you manipulate databases seamlessly. Create and modify 
tables, forms, queries, and reports, all from within OpenOffice.org 

 

Math– lets you create mathematical equations with a graphic user 
interface or by directly typing your formulas into the equation editor. 

 
(Click on each program to see the features) 
 
 

DOWNLOAD YOUR FREE WORD PROCESSING SOFTWARE "OPENOFFICE" 
 

To Start Download For WINDOWS Users CLICK HERE 
 
1. Click the download box that says "Download OpenOffice.org 3.2.1" 
 
2. On the next page check the file should download automatically, if not, check your download tool bar on top of 
screen to allow the "Download File" (This is the little yellow toolbar that will popup during download). 
 
3. Save the file to your desktop. (Allow a few minutes to complete download). 
 
4. Click the OpenOffice download icon on your desktop to start downloading to your computer. 
 
5. Click the "NEXT" button, then click the "UNPACK" button to start the download. 
 
6. You will then start the download, follow the directions as given during installation. 
 

To Start Download For MAC OS X Users CLICK HERE 
 

1. First you will need to select your MAC operating system, i.e. MAC OS X 10.5 (Leopard), MAC OS X 10.4 (Tiger), 
etc. 
 
2. On the next page, you will select your processor type for MAC. 
 
3. On the next page, you will choose your language. 
 
4. The download should start automatically. If not choose the "download overview" option to manually start 

http://www.openoffice.org/product/writer.html
http://www.openoffice.org/product/calc.html
http://www.openoffice.org/product/impress.html
http://www.openoffice.org/product/draw.html
http://www.openoffice.org/product/base.html
http://www.openoffice.org/product/math.html
http://download.openoffice.org/index.html
http://download.openoffice.org/index.html
http://porting.openoffice.org/mac/download/x11.html
http://porting.openoffice.org/mac/download/x11.html


download. 

 
5. Save the file to your desktop. (Allow a few minutes to complete download). 
 
6. Click the OpenOffice download icon on your desktop to start downloading to your computer. 
 
7. Follow the directions as given during installation. 

4. Introduction to your Word Processor 
It is time to start the training on how to use your word processor. If you know how to type, then the 

word processor will do all the rest for you when you know how to use the features it provides. So we are 
going to focus our training program on teaching you all the features of your word processor. Once you 

learn how to use the word processor, you will be able to do many data-entry jobs and assignments that 
come your way. 

 

Training for word processor software - We will give you detailed training for BOTH word processors 
(Microsoft Word and OpenOffice). If you downloaded OpenOffice then that is the training you will do. If 

you already have Microsoft Word, then that is the training you will do. 
 

Core concepts and skills - No matter which word processor you use, you'll find there's a core set of 

concepts and techniques that apply to them all. If you become proficient in one word processor, you'll 
find it not at all hard to learn how to create documents in any word processor. If you get to know 

OpenOffice, you'll find similar tools available in in Microsoft Word, Corel, Lotus, and so on. Basically what 
we are telling you is once you learn one word processor, you will be able to work all of them. 

 
So when you are ready, open up your Microsoft Word, OpenOffice, or whatever word processor you are 

using and select which training program you want to proceed with. 

5. How to Use your Word Processor 
So when you are ready, open up your Microsoft Word, or whatever word processor you are using and 
select which training program you want to proceed with. 

 
 

 
TRAINING 

THIS IS ONLY FOR MEMBERS WHO ALREADY HAVE MICROSOFT OFFICE WORD. You do not need Microsoft 

Office to do the assignments, this is why we give you the free OpenOffice and training above. 

 

We will give you a very detailed step-by-step training program on exactly how to use Microsoft Office word 

processor.  

 

Microsoft Word Training 



Getting to know your Microsoft Word processor! 
 

 
Menus and Toolbars 

Screen Layout 

 

Menus 
When you begin to explore Word 2000, you will notice a significant change in the menu 

structure if you are familiar with previous versions of Word. The menus in Word 2000 

display only the commands you have recently used. To view all options in each menu, you 

must click the double arrows at the bottom of the menu. The images below show the 

Format menu collapsed (left) and expanded (right) after the double arrows at the bottom of 
the menu were clicked: 



 

Follow the steps below to display menus similar to previous versions of Word with all the 

choices listed initially: 

 

 

Select View|Toolbars|Customize from the menu bar.  

Click on the Options tab.  
Uncheck the Menus show recently used commands first check box. 

 



Shortcut Menus 

These features allow you to access various Word commands faster than using the options on 

the menu bar. View shortcut menus by right-clicking with the mouse. The options on this 

menu will vary depending on the element that was right-clicked. For example, the shortcut 
menu below is produced by right-clicking on a bulleted list.  

 

Actions such as "Decrease Indent" and "Increase Indent" are only applicable to lists and 

therefore only appear on the list shortcut menu. The shortcut menus are helpful because 

they only display the options that can be applied to the item that was right-clicked and, 
therefore, prevent searching through the many menu options. 

Toolbars 

Many toolbars displaying shortcut buttons are also available to make editing and formatting 

quicker and easier. Select View|Toolbars from the menu bar to select the toolbars. The 

toolbars that are already displayed on the screen are checked. Add a toolbar simply by 
clicking on the name. 



 

Customizing Toolbars 

There may be certain actions on a toolbar that you do not use and there may also be 

commands that you execute often but that are not located on any toolbar. Word toolbars 
can be customized so these commands can be added and deleted. 

Select View|Toolbars|Customize and click the Commands tab. 



 

By highlighting the command categories in the Categories box, the choices will change in 

the Commands box to the right.  

Select the command you would like to add to the toolbar by selecting it in the Commands 

box.  

Drag the command with the mouse to the desired location on the toolbar and release the 

mouse button.  
Remove a button from the toolbar by clicking and dragging the button off the toolbar.  

  

Working With Files 

Create a New Document 

Click the New Document button on the menu bar.  

Choose File|New from the menu bar.  

Press CTRL+N (depress the CTRL key while pressing "N") on the keyboard. 

 

 

Open an Existing Document 

Click the Open File button on the menu bar.  

Choose File|Open from the menu bar.  
Press CTRL+O on the keyboard.  

Each method will show the Open dialog box. Choose the file and click the Open button.  



 

  

Save a Document  

Click the Save button on the menu bar.  

Select File|Save from the menu bar.  
Press CTRL+S on the keyboard.  

Renaming Documents 

To rename a Word document while using the program,select File|Open and find the file you 

want to rename. Right-click on the document name with the mouse and select Rename 

from the shortcut menu. Type the new name for the file and press the ENTER key. 



 

Working on Multiple Documents 

Several documents can be opened simultaneously if you are typing or editing multiple 

documents at once. All open documents are listed under the Window menu as shown 

below. The current document has a checkmark beside the file name. Select another name to 

view another open document or click the button on the Windows taskbar at the bottom of 
the screen. 

 

Close a Document 

Close the current document by selecting File|Close or click the Close icon if it's visible on 

the Standard Toolbar.  

 
 
 

Working With Text 



Typing and Inserting Text 

To enter text, just start typing! The text will appear where the blinking cursor is located. 

Move the cursor by using the arrow buttons on the keyboard or positioning the mouse and 

clicking the left button. The keyboard shortcuts listed below are also helpful when moving 
through the text of a document: 

  

Move Action Keystroke 

Beginning of the line HOME 

End of the line END 

Top of the document CTRL+HOME 

End of the document CTRL+END 

Selecting Text 

To change any attributes of text it must be highlighted first. Select the text by dragging the 

mouse over the desired text while keeping the left mouse button depressed, or hold down 

the SHIFT key on the keyboard while using the arrow buttons to highlight the text. The 
following table contains shortcuts for selecting a portion of the text: 

  

Selection Technique 

Whole word double-click within the word 

Whole paragraph triple-click within the paragraph 

Several words or lines drag the mouse over the words, or hold down SHIFT while using the arrow keys 

Entire document choose Edit|Select All from the menu bar, or press CTRL+A 

Deselect the text by clicking anywhere outside of the selection on the page or press an 

arrow key on the keyboard. 

Deleting Text 

Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will 

delete text to the left of the cursor and Delete will erase text to the right. To delete a large 

selection of text, highlight it using any of the methods outlined above and press the 

DELETE key.  

Formatting Text 

The formatting toolbar is the easiest way to change many attributes of text. If the toolbar 

as shown below isn't displayed on the screen, select View|Toolbars and choose 
Formatting. 



 

 Style Menu - Styles are explained in detail later in this tutorial.  

 Font Face - Click the arrowhead to the right of the font name box to view the list 

of fonts available. Scroll down to the font you want and select it by clicking on the 

name once with the mouse. A serif font (one with "feet" circled in the illustration 

below) is recommended for paragraphs of text that will be printed on paper as 

they are most readable. The following graphic demonstrates the difference 

between serif (Times New Roman on the left) and sans-serif ("no feet", Arial on 

the right) fonts. 

 
 Font Size - Click on the white part of the font size box to enter a value for the 

font size or click the arrowhead to the right of the box to view a list of font sizes 

available. Select a size by clicking on it once. A font size of 10 or 12 is best for 

paragraphs of text. 

 Font Style - Use these buttons to bold, italicize, and underline text. 

 Alignment - Text can be aligned to the left, center, or right side of the page or it 

can be justified across the page.  

 Numbered and Bulleted Lists - Lists are explained in detail later in this tutorial.  

 Increase/Decrease Indent - Change the indentation of a paragraph in relation 

to the side of the page. 

 Outside Border - Add a border around a text selection. 

 Highlight Color - Use this option to change the color behind a text selection. The 

color shown on the button is the last color used. To select a different color, click 

the arrowhead next to the image on the button. 

 Text Color - This option changes the color of the text. The color shown on the 

button is the last color chosen. Click the arrowhead next to the button image to 

select another color. 

 

The Font dialog box allows you to choose from a larger selection of formatting 
options. Select Format|Font from the menu bar to access the box.  



 

Format Painter  

A handy feature for formatting text is the Format Painter located on the standard toolbar. 

For example, if you have formatting a paragraph heading with a certain font face, size, and 

style and you want to format another heading the same way, you do not need to manually 

add each attribute to the new headline. Instead, use the Format Painter by following these 
steps:  

Place the cursor within the text that contains the formatting you want to copy. Click the 

Format Painter button in the standard toolbar. Notice that your pointer now has a 

paintbrush beside it. 

Highlight the text you want to add the same format to with the mouse and release the 
mouse button.  

To add the formatting to multiple selections of text, double-click the Format Painter button 

instead of clicking once. The format painter then stays active until you press the ESC key to 

turn it off.  

Undo  

Feel free to experiment with various text styles. You can always undo your last action by 

clicking the Undo button on the standard toolbar or selecting Edit|Undo... from the menu 

bar. Click the Redo button on the standard toolbar or select Edit|Redo... to erase the undo 



action. 

 

 

 

Formatting Paragraphs 

Paragraph Attributes 

Format a paragraph by placing the cursor within the paragraph and selecting 
Format|Paragraph from the menu bar. 

 

Moving (Cutting) Text  

Highlight the text that will be moved and select Edit|Cut from the menu bar, click the Cut 

button on the standard tool bar, or press CTRL+X at once. This will move the text to a 

clipboard. 

To move a small amount of text a short distance, the drag-and-drop method may be 

quicker. Highlight the text you want to move, click the selection with the mouse, drag the 
selection to the new location, and release the mouse button. 

Copying Text  

To copy text, choose Edit|Copy, click the Copy button on the standard toolbar, or press 
CTRL+C to copy the text to the clipboard. 



Paste Text  

To paste cut or copied text, move the cursor to the location you want to move the text to 

and select Edit|Paste from the menu bar, click the Paste button on the standard toolbar, 
or press CTRL+V.  

The Clipboard 

The last 12 elements that were cut or copied are placed onto Word's clipboard. You can view 

the elements on the clipboard by selecting View|Toolbars|Clipboard from the menu bar. 

 

Place the mouse arrow over each element in the clipboard to view the contents of each item 

and click on an element to add its contents to the document. Click Paste All to add all of 

the items to the document at once. Click the Clear Clipboard button (the icon with an "X" 
over the clipboard image) to clear the contents of the clipboard. 

Columns  

To quickly place text in a column format, click the Columns button on the standard toolbar 
and select the number of columns by dragging the mouse over the diagram. 

 

For more column options, select Format|Columns from the menu bar. The Columns 

dialog box allows you to choose the properties of the columns. Select the number and width 
of the columns from the dialog box. 



 

Drop Caps 

A drop cap is a large letter that begins a paragraph and drops through several lines of text 
as shown below. 

 

Add a drop cap to a paragraph by following these steps: 

1. Place the cursor within the paragraph whose first letter will be dropped.  

2. Select Format|Drop Cap from the menu bar.  

3. The Drop Cap dialog box allows you to select the position of the drop cap, the 

font, the number of lines to drop, and the distance from the body text.  

4. Click OK when all selections have been made.  

5. To modify a drop cap, select Format|Drop Cap again to change the attributes, or 
click on the letter and use the handles to move and resize the letter.  



Styles 
The use of styles in Word will allow you to quickly format a document with a consistent and 
professional look. Paragraph and character styles can be saved for use in many documents. 

 

Applying a Style 
Place the cursor in the paragraph where the style will be applied.  

1. Click the Style drop-down menu on the Formatting toolbar and select a style by clicking on 
it.  

2. To apply the same style to multiple paragraphs, double click the Format Painter button 

on the standard toolbar and click in all the paragraphs that the style should be applied 

to. Press the ESC key to disable the Format Painter.  

Apply a Style from the Style Dialog Box 
Choose from a larger selection of styles from the Style dialog box. 



 

1. Click in the paragraph you want to add a style to.  
2. Select Format|Style... from the menu bar.  
3. From the List drop-down menu, choose All styles to view all the styles available.  
4. The styles are displayed in the Styles list. Preview each style by clicking once on the 

name. Paragraph styles are preceded by the paragraph symbol ( ) and character styles are 
preceded by an "a" icon ( ). A pointer arrow is located next to the current style. Highlight 
the style you want to apply to the paragraph and click Apply.  

Create a New Style from a Model 
To create a style from text that is already formatted in a document, follow these steps: 

1. Place the cursor in the paragraph you would like to set as a new style.  
2. Click the Style box on the formatting toolbar so the style name is highlighted. 

 



3. Delete the text in the field and type the name of the new style.  
4. Press the ENTER key to save the new style.  

Create a Simple Style from the Style Dialog Box 
Select Format|Style... from the menu bar and click the New button on the Style dialog box to 
access the New Style dialog box.  

 

  

1. Type the name for the new style in the Name field.  

2. Select "Paragraph" or "Character" from the Style type drop-down menu.  
3. Click the Format button at the bottom of the window and choose the paragraph element 

that will be formatted for the style. Continue to make changes from the options from the 
Format button menu, making changes to the dialog boxes for each element you choose.  

4. Click OK to set the style and close the New Style dialog box.  
5. Click Apply on the Style dialog box to apply the new style to the current paragraph.  

Modify or Rename a Style 
An existing style can be changed from the Style dialog box. 

1. Select Format|Style... from the menu bar.  
2. Highlight the style from the Styles list that you want to modify and click the Modify 

button. 



 

3. Use the same methods to modify the style from the Modify Style dialog box that were 

used for the New Style box.  
4. To only rename the style, type a new name in the Name field.  
5. Click OK when you are finished making modifications.  
6. Click Apply to update the style in the document.  

Delete a Style 
Preset styles created by Word cannot be deleted, but to delete a style you have made, follow these 
steps: 

1. Select Format|Style... from the menu bar  
2. Highlight the style from the Styles list that you want to delete.  
3. Click the Delete button.  
4. You will be asked if you really want to delete the style. Click Yes.  
5. Click Close on the dialog box.  

Lists 

To create a bulleted or numbered list, use the list features provided by Word.  

Bulleted and Numbered Lists  

1. Click the Bulleted List button or Numbered List button on the formatting toolbar.  

2. Type the first entry and press ENTER. This will create a new bullet or number on the next 
line. If you want to start a new line without adding another bullet or number, hold down 
the SHIFT key while pressing ENTER.  

3. Continue to typing entries and press ENTER twice when you are finished typing to end the 
list.  

Use the Increase Indent and Decrease Indent buttons on the formatting toolbar to create 
lists of multiple levels. 



NOTE: You can also type the text first, highlight the section, and press the Bulleted List or 
Numbered List buttons to add the bullets or numbers.  

Nested Lists 
To create a nested list, such as a numbered list inside of a bulleted list, follow these steps: 

1. Type the list and increase the indentation of the items that will make up the nested list by 
clicking the Increase Indent button for each item. 

 

2. Highlight the items and click the Numbered List button on the formatting toolbar.  

Formatting Lists 
The bullet image and numbering format can be changed by using the Bullets and Numbering dialog 
box. 

1. Highlight the entire list to change all the bullets or numbers, or 
Place the cursor on one line within the list to change a single bullet.  

2. Access the dialog box by selecting Format|Bullets and Numbering from the menu bar or 
by right-clicking within the list and selecting Bullets and Numbering from the shortcut 
menu. 

 



3. Select the list style from one of the seven choices given, or click the Picture... button to 

choose a different icon. Click the Numbered tab to choose a numbered list style.  
4. Click OK when finished.  

Tables 

Tables are used to display data and there are several ways to build them in Word. Begin by placing 
the cursor where you want the table to appear in the document and choose one of the following 
methods. 

Insert a Table 
There are two ways to add a table to the document using the Insert feature: 

1. Click the Insert Table button on the standard toolbar. Drag the mouse along the grid, 
highlighting the number of rows and columns for the table. 

 

 

2. Or, select Table|Insert|Table from the menu bar. Select the number of rows and 
columns for the table and click OK. 

 



Draw the Table 
A table can also be drawn onto the document: 

1. Draw the table by selecting Table|Draw Table from the menu bar. The cursor is now the 
image of a pencil and the Tables and Borders toolbar has appeared. 

 

2. Draw the cells of the table with the mouse. If you make a mistake, click the Eraser button 

and drag the mouse over the area to be deleted.  

3. To draw more cells, click on the Draw Table button .  

Inserting Rows and Columns 

Once the table is drawn, insert additional rows by placing the cursor in the row you want to be 
adjacent to. Select Table|Insert|Rows Above or Rows Below. Or, select an entire row and right-
click with the mouse. Choose Insert Rows from the shortcut menu. 
 
Much like inserting a row, add a new column by placing the cursor in a cell adjacent to where the new 
column will be added. Select Table|Insert|Columns to the Left or Columns to the Right. Or, 
select the column, right-click with the mouse, and select Insert Columns. 

Moving and Resizing a Table 
A four-sided moving arrow and open box resizing handle will appear on the corners of the table if the 

mouse is placed over the table. Click and drag the four-ended arrow to move the table and release the 
mouse button when the table is positioned where you want it. Click and drag the open box handle to 
resize the table. Change the column widths and row heights by clicking the cell dividers and dragging 
them with the mouse. 

 

Tables and Borders Toolbar 
The Tables and Borders toolbar allows you to add border styles, shading, text effects, alignment, and 
more options to your table. Access the toolbar by clicking Table|Draw Table or 
View|Toolbars|Tables and Borders. 

 

You will need to highlight the cells of the table you want to format. Click and drag the mouse over the 
cells, or use the following shortcuts: 

Selection Menu Method Mouse Method 



One cell Table|Select|Cell 
Click the bottom, left corner of the cell when a black arrow 

appears  

One row Table|Select|Row Click outside the table to the left of the row 

One column Table|Select|Column 
Click outside the table above the column when a black arrow 

appears 

Several rows (none) 
Click outside the table to the left of the row and drag the mouse 

down 

Several 

columns 
(none) Click outside the table above the column 

Entire table Table|Select|Table Triple-click to the left of the table 

Table Properties 
Use the Table Properties dialog box to modify the alignment of the table with the body text and the 
text within the table. Access the box by selecting Tables|Table Properties. 

 

 Size - Check the Preferred width box and enter a value if the table should be an exact 

width.  

 Alignment - Highlight the illustration that represents the alignment of the table in relation 
to the text of the document.  

 Text wrapping - Highlight "None" if the table should appear on a separate line from the 

text or choose "Around" if the text should wrap around the table.  

 Borders and Shading - Select from a number of border styles, colors, and widths. Click 
the Shading tab to change the background color and pattern. 



 

 Options - Click the Options button on the Table Properties window. To change the 

spacing between the document text and the table borders under Default cell margins. 
Check the Allow spacing between cells box and enter a value to add space between the 
table cells. 

 

Graphics 

Adding Clip Art 
To add a clip art image from the Microsoft library to a document, follow these steps: 



1. Select Insert|Picture|Clip Art from the menu bar. 

 

2. To find an image, click in the white box following Search for clips. Delete the words "Type 
one or more words. . ." and enter keywords describing the image you want to use. 
- OR - 
Click one of the category icons.  

3. Click once on the image you want to add to the document and the following popup menu 

will appear: 

 
o Insert Clip to add the image to the document. 

o Preview Clip to view the image full-size before adding it to the document. Drag 
the bottom, right corner of the preview window to resize the image and click the 



"x" close button to end the preview. 

 
o Add Clip to Favorites will add the selected image to your favorites directory that 

can be chosen from the Insert ClipArt dialog box.  

o Find Similar Clips will retrieve images similar to the one you have chosen.  
4. Continue selecting images to add to the document and click the Close button in the top, 

right corner of the Insert ClipArt window to stop adding clip art to the document. 

Add An Image from a File 
Follow these steps to add a photo or graphic from an existing file: 

1. Select Insert|Picture|From File on the menu bar. 
2. Click the down arrow button on the right of the Look in: window to find the image on your 

computer.  
3. Highlight the file name from the list and click the Insert button. 

 

Editing A Graphic 
Activate the image you wish to edit by clicking on it once with the mouse. Nine handles will appear 



around the graphic. Click and drag these handles to resize the image. The handles on the corners will 

resize proportionally while the handles on the straight lines will stretch the image. More picture effects 
can be changed using the Picture toolbar. The Picture toolbar should appear when you click on the 
image. Otherwise, select View|Toolbars|Picture from the menu bar to activate it. 

 

 Insert Picture will display the image selection window and allows you to change the 

image. 

 Image Control allows to make the image grayscale, black and white, or a watermark. 

 More/Less Contrast modifies the contrast between the colors of the image. 

 More/Less Brightness will darken or brighten the image. 

 Click Crop and drag the handles on the activated image to delete outer portions of the 

image. 

 Line Style will add a variety of borders to the graphic. 

 Text Wrapping will modify the way the document text wraps around the graphic. 

 Format Picture displays all the image properties in a separate window. 

 Reset Picture will delete all the modifications made to the image.  

Auto Shapes 
The AutoShapes toolbar will allow you to draw many different geometrical shapes, arrows, flow chart 
symbols, stars, and banners on the document. Activate the AutoShapes toolbar by selecting 
Insert|Picture|AutoShapes or View|Toolbars|AutoShapes from the menu bar, or clicking the 
AutoShapes button on the Drawing toolbar. Click each button on the toolbar to view the options for 
drawing the shape. 

 

 Lines - After clicking the Lines button on the AutoShapes toolbar, draw a straight line, 

arrow, or double-ended arrow from the first row of options by clicking the respective 



button. Click in the document where you would like the line to begin and click again where 

it should end. To draw a curved line or freeform shape, select curved lines from the 
menu (first and second buttons of second row), click in the document where the line should 
appear, and click the mouse every time a curve should begin. End creating the graphic by 

clicking on the starting end or pressing the ESC key. To scribble, click the last button in 
the second row, click the mouse in the document and hold down the left button while you 
draw the design. Let go of the mouse button to stop drawing. 

 Basic Shapes - Click the Basic Shapes button on the AutoShapes toolbar to select from 
many two- and three-dimensional shapes, icons, braces, and brackets. Use the 
drag-and-drop method to draw the shape in the document. When the shape has been 

made, it can be resized using the open box handles and other adjustments specific to each 
shape can be modified using the yellow diamond handles. 

 
 Block Arrows - Select Block Arrows to choose from many types of two- and three-

dimensional arrows. Drag-and-drop the arrow in the document and use the open box 
and yellow diamond handles to adjust the arrowheads. Each AutoShape can also be rotated 

by first clicking the Free Rotate button on the drawing toolbar . Click and drag the 
green handles around the image to rotate it. The tree image below was created from an 
arrow rotated 90 degrees. 

 
 Flow Chart - Choose from the flow chart menu to add flow chart elements to the 

document and use the line menu to draw connections between the elements. 

 Stars and Banners - Click the button to select stars, bursts, banners, and scrolls.  

 Call Outs - Select from the speech and thought bubbles, and line call outs. Enter the 

call out text in the text box that is made. 

 More AutoShapes - Click this button to choose from a list of clip art categories.  

Each of the submenus on the AutoShapes toolbar can become a separate toolbar. Just click and drag 
the gray bar across the top of the submenus off of the toolbar and it will become a separate floating 
toolbar. 

  



 

 

 
 
 
 

Spelling and Grammar 

AutoCorrect 
Word automatically corrects many commonly misspelled words and punctuation marks with the 

AutoCorrect feature. To view the list of words that are automatically corrected, select 
Tools|AutoCorrect. This may be a hidden feature so click the double arrows at the bottom of the 
Tools menu listing if the AutoCorrect choice is not listed. 

 

Many options including the accidental capitalization of the first two letters of a word and capitalization 

of the first word of the sentence can be automatically corrected from this page. If there are words you 
often misspell, enter the wrong and correct spellings in the Replace and With fields. 



Spelling and Grammar Check 

Word will automatically check for spelling and grammar errors as you type unless you turn this feature 
off. Spelling errors are noted in the document with a red underline. Grammar errors are indicated by a 
green underline. To disable this feature, select Tools|Options from the menu bar and click the 

Spelling and Grammar tab on the dialog box. Uncheck "Check spelling as you type" and "Check 
grammar as you type", and click OK. 

To use the spelling and grammar checker, follow these steps: 

1. Select Tools|Spelling and Grammar from the menu bar.  

2. The Spelling and Grammar dialog box will notify you of the first mistake in the document 
and misspelled words will be highlighted in red. 

 
3. If the word is spelled correctly, click the Ignore button or click the Ignore All button if 

the word appears more than once in the document.  

4. If the word is spelled incorrectly, choose one of the suggested spellings in the 
Suggestions box and click the Change button or Change All button to correct all 
occurrences of the word in the document. If the correct spelling is not suggested, enter the 
correct spelling in the Not In Dictionary box and click the Change button.  

5. If the word is spelled correctly and will appear in many documents you type (such as your 
name), click the Add button to add the word to the dictionary so it will no longer appear as 
a misspelled word.  

As long as the Check Grammar box is checked in the Spelling and Grammar dialog box, Word will 
check the grammar of the document in addition to the spelling. If you do not want the grammar 

checked, remove the checkmark from this box. Otherwise, follow these steps for correcting grammar: 



1. If Word finds a grammar mistake, it will be shown in the box as the spelling errors. The 

mistake is highlighted in green text. 

 
2. Several suggestions may be given in the Suggestions box. Select the correction that best 

applies and click Change.  
3. If no correction is needed (Word is often wrong more than it is right), click the Ignore 

button.  

Synonyms 
Word 2000 has a new feature for finding synonyms. Simply right-click on the word and select 
Synonyms from the shortcut menu. From the list of suggested words, highlight the word you would 
like to use or click Thesaurus... for more options. 

 



Thesaurus 

To use the thesaurus, select Tools|Language|Thesaurus from the menu bar or select it from the 
Synonyms shortcut menu as detailed above. 

 

A list of meanings and synonyms are given on the windows. Double-click on the words in the 
Meanings box or click the Look Up button to view similar words. Double-click words in the Replace 

with Synonym box to view synonyms of those words. Highlight the word you would like to add and 
click the Replace button. 
 
 
 

Page Formatting 

Page Margins 
The page margins of the document can be changed using the rulers on the page and the Page Setup 
window. The ruler method is discussed first: 

1. Move the mouse over the area where the white ruler changes to gray. 

 
2. When the cursor becomes a double-ended arrow, click with the mouse and drag the margin 

indicator to the desired location.  
3. Release the mouse when the margin is set.  

The margins can also be changed using the Page Setup dialog box: 



1. Select File|Page Setup and choose the Margins tab in the dialog box. 

 
2. Enter margin values in the Top, Bottom, Left, and Right boxes. The Preview window will 

reflect the changes.  
3. If the document has Headers and/or Footers, the distance this text appears from the 

edge of the page can be changed.  
4. Click OK when finished. 

Page Size and Orientation 
Change the orientation page within the Page Setup dialog box. 

1. Select File|Page Setup and choose the Paper Size tab. 

 
2. Select the proper paper size from the drop-down menu.  
3. Change the orientation from Portrait or Landscape by checking the corresponding radio 

button. 

Headers and Footers 
A header is text that is added to the top margin of every page such as a document title or page 
number and a footer is text added to the bottom margin. Follow these steps to add or edit headers 
and footers in the document: 



1. Select View|Header and Footer from the menu bar. The Header and Footer toolbar will 

appear and the top of the page will be highlighted as shown below. 

 
2. Type the heading in the Header box. You may use many of the standard text formatting 

options such as font face, size, bold, italics, etc.  

3. Click the Insert AutoText button to view a list of quick options available.  
4. Use the other options on the toolbar to add page numbers, the current date and time.  
5. To edit the footer, click the Switch Between Header and Footer button on the toolbar.  
6. When you are finished adding headers and footers, click the Close button on the toolbar.  

Page Numbers 
Follow these instructions for another way to add page numbers to a document. 

1. Select Insert|Page Numbers from the menu bar and the following dialog box will appear. 

 
2. Select the position of the page numbers by choosing "Top of page" or "Bottom of page" 

from the Position drop-down menu.  

3. Select the alignment of the page numbers in the Alignment drop-down menu.  
4. If you do not want the page number to show on the first page (if it is a title page, for 

example), uncheck the Show number of first page box.  
5. Click OK when finished.  

Print Preview and Printing 
Preview your document by clicking the Print Preview button on the standard toolbar or by selecting 
File|Print Preview. When the document is ready to print, click the Print button from the Print 



Preview screen or select File|Print. 

 
 
 

 

Macros 

Macros are advanced features that can speed up editing or formatting you may perform often in a 
Word document. They record sequences of menu selections that you choose so that a series of actions 
can be completed in one step.  

Recording A Macro 
To record a macro, follow these steps: 

1. Click Tools|Macro|Record New Macro on the menu bar. 

 
2. Name the macro in the Macro name field. This name cannot contain spaces and or begin 

with a number.  
3. From the Store macro in drop-down box, select the document you would like the macro 

to be associated with or choose "All Documents" be able to use the macro in any 
document.  

4. Enter a description of the macro in the Description field. This is for your reference only so 
you remember what the macro does.  

5. Click OK to begin recording.  
6. Select options from the drop-down menus and Word will record the options you choose 

from the dialog boxes, such as changing the margins on the Page Setup window. Select 
only options that modify the document. Word will not record toggle actions such as 
View|Toolbars that have no effect on the document itself.  

7. The recording toolbar will allow you to stop, pause, and resume recording. 

 
8. Click the Stop button the recording toolbar. The macro is now saved.  

Running A Macro 
To run an existing macro, follow these steps. 

1. Select Tools|Macro|Macros from the menu bar.  



2. From the Macros window, highlight the Macro name in the list and click Run. 

 
3. If the macro is long and you want to stop it while it is running, press BREAK (hold CTRL 

and press PAUSE).  

Table of Contents 

Word will automatically create a Table of Contents page if a document is designed using Heading and 
Paragraph styles (see the Styles section). Follow the steps on this page to create a Table of Contents. 

Mark Table of Contents Entries 

1. Highlight a heading that you would like to appear in the Table of Contents (TOC).  
2. Press ALT+SHIFT+O and the Mark Table of Contents Entry box will appear. 

 
3. Entry - Rename the entry if you would like a different heading to appear in the TOC.  
4. Table identifier - Select "C".  
5. Level - Choose "1" for first-level heading, "2" for second-level heading, etc.  

6. Click the Mark button.  
7. The document will be toggled to "reveal codes" view and notice the TOC field code. To hide 

all codes click the Show/Hide codes button on the standard toolbar.  

8. Select another heading to add to the TOC, or click the Close button on the Mark Table of 
Contents Entry dialog box.  

Generate a Table of Contents 

http://www.fgcu.edu/support/office2000/word/styles.html


After you have marked all the headings for your TOC, follow these steps to generate the Table of 
Contents. 

1. Place the cursor where you would like the TOC to appear in the document.  
2. Select Insert|Index and Tables from the menu bar. 

 
3. Customize the appearance of the TOC from the Table of Contents tab. You may choose a 

preset design from the Formats drop-down menu. A preview of each design will be shown 

in the Print Preview window.  
4. Check the Show page numbers box if you would like page numbers to show on the TOC. 

Check the Right align page numbers box if the page numbers should appear on the right 
side, then select the Tab leader between the heading and the page number. Uncheck the 
box if the page numbers should appear right next to the heading.  

5. Click OK.  

What we have shown you is all the important features you will be working with in your word 
processor. These are very simple things to learn. Now that you know what all the features your word 
processor has, it is time to learn how to put it to use. 

 

Learning The Basics of Microsoft Word -Audio/Visual Guide 
We are going to have you watch an audio/visual presentation from Microsoft on learning 

some basics of Microsoft Word. This will help you to get a more complete understanding of 

how to open up, create, format, and edit a document. 

 



 
 

CLICK HERE TO START AUDIO/VISUAL COURSE 
 

Using Word Processor For Specific Projects 
We are going to give more specific training for specific job tasks and assignments you may 

see when working as a work-from-home data processor. Knowing how to do each of these 

tasks will take the guesswork out of completing an assignment. 

 

We are going to give you some more audio/visual tutorial. 
 

Creating Mail Merge and Letter Documents 
This is a very common assignment for creating mass mailings, and personal mailings for companies. 

We are going to give you an audio/visual tutorial on this. 
 

 
 
 

CLICK HERE TO START AUDIO/VISUAL COURSE 

 
 
 

Creating Tables and Cells for Spreadsheets 
Creating spreadsheets in your word processor can be done in a couple of different ways; for one you 
can transfer a spreadsheet from an existing program such as Microsoft Excel, or create cells and 
tables to insert the data. 
 

 
 
 

CLICK HERE TO START AUDIO/VISUAL COURSE 

 
 
 

Editing Tables and Cells Using Outside Sources 
This tutorial will deal with using outside editors to create spreadsheets, tables, rows etc. 

http://office.microsoft.com/training/training.aspx?AssetID=RC100140951033
http://office.microsoft.com/training/training.aspx?AssetID=RC011205671033
http://office.microsoft.com/training/training.aspx?AssetID=RC012006821033


 
 
 
 

CLICK HERE TO START AUDIO/VISUAL COURSE 

 
 
 

Adding Graphics and Decor to a Presentation 
Adding graphics to a presentation, letter, flier, etc. will be an important feature to learn.  

 
 
 

CLICK HERE TO START AUDIO/VISUAL COURSE 
 
 
Part 2 
Backgrounds, borders and decor to document 

CLICK HERE TO START AUDIO/VISUAL COURSE 

 
 

 

 

Document Outlining 
Some companies will have create document outlines from scratch, and this is a perfect audio/visual 
tutorial on exactly how to do this. 

 

 
 
 

CLICK HERE TO START AUDIO/VISUAL COURSE 

 

 
 

XML Formatting and Documentation 
It will be important to understand what XML, is and how popular it will be when you are doing 

outsource assignments.  
 

http://office.microsoft.com/training/training.aspx?AssetID=RC100808761033
http://office.microsoft.com/training/training.aspx?AssetID=RC010264821033
http://office.microsoft.com/training/training.aspx?AssetID=RC010264821033
http://office.microsoft.com/training/training.aspx?AssetID=RC011313811033
http://office.microsoft.com/training/training.aspx?AssetID=RC061050921033


 
 
 

CLICK HERE TO START AUDIO/VISUAL COURSE 

 
 
 

Data Research 

You will always need to do a little research when working on any assignments, this tutorial will teach 
you how to easily do your research using features in your word processor. 
 

 
 
 

CLICK HERE TO START AUDIO/VISUAL COURSE 

 

 

6. Basic Rules and Tips on Using Word Processor 

Using a word processing program like Microsoft Word, WordPerfect, OpenOffice or Microsoft Works is fairly easy and 
intuitive to use if you can remember a few things. Most people who grew up with typewriters, try to use a word 
processor program just like a typewriter, which is not how this software was meant to be used. Even those who have 
never used a typewriter tend to overlook many of the valuable features of a word processor program. 

The true value of a word processing program is in its flexibility. With a typewriter, if you made a change to the first 
page of a long document, you had to retype the entire document. With a word processor, if you make a change to 
the first page of a document, all the other pages will adjust to that change automatically. That is, the adjustments 
will be made if you have created the document properly. 
 
If you have already done one of the two word processors training above, then you will have an understanding of the 
terms we use in this next section. We are going to give you some great pointers, tips and rules you should know that 
will make using a word processor for your work easier and more manageable. 
 
 

Three Basic Rules 
There are three essential rules for learning any computer application:  

1. Look at the screen. 

2. Don't work on an urgent task while you're learning. 
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3. Save constantly. 

Rule One: Look at the screen. 

Most beginners don't look at their computer screens. Oh, they take a peek and think "Oh my, how 

confusing". But that's not really looking. The best way to start to get to know a program is to take a good 
long look at everything on your screen and become familiar with it. For instance, when you first start up 

your word processor, before you type a single word, look at the menus and toolbars (the little strips of 
tiny pictures – called 'icons' or 'toolbar buttons') across the top of your screen. Let your mouse pointer 

pause on each button in the toolbar and you'll see either a little label pop up indicating what it does, or 
you'll see a message down in the status bar (the very bottom of the word processing window) with the 

same information. 

In the latest versions of WordPerfect, you'll see similar pop-up labels for the menus as well as the 

toolbars. 

Notice how each toolbar button gives a graphic representation of its function: a little disk on the button 

which lets you save your work; a picture of a printer on the button which lets you print your work; and so 
on. 

 
Common menus 

Each word processing program has its own particular set of toolbars and menus, but many of the 
functions are similar. Most programs will have a File Menu, a Format or Text Menu, and a Help Menu, 

plus several others. 

Take a look in the Help Menu. Online help is getting better and better and the advanced word processing 

programs have help 'wizards' or 'assistants' that will take your written question, for instance, "How do I 
change the size of my text?" and display the appropriate answer for you. 

The File Menu is equally important. From the File Menu you can create a new document, open one you've 
already created, save and close documents, print documents and perform various other tasks affecting 

your files. 

Alt key shortcuts 

See how each menu has one of its letters underlined? There's a reason: instead of opening the menus by 
pointing and clicking with your mouse, you can hold down the Alt key and press the underlined letter to 

open that particular menu (press the "Esc" key to close the menu without making a selection). 

Open any menu and have a look at its contents. Some items are greyed out, indicating that option is 

currently unavailable. For example, the Table Menu in Word for Windows has most of its options greyed 
out unless you insert a table into your document (useful for creating neat columns of related text) and 

select the table.The meaningful ellipsis (...) 

Some options in each menu contain a word or phrase, some have a word or phrase followed by an 

ellipsis (. . .). The ellipsis indicates that when you select the menu option, a dialog box will open giving 
you more control over the option. For example, in most word processors, if you click the toolbar 'Print' 

button, the word processor will automatically print all of your current document. If you use the File Menu 
Print option instead of the toolbar button, you'll be presented with a dialog box that lets you choose 

which pages of the document to print, which printer to use for printing (if you have more than one 

connected to your computer) and so on. 

The toolbar buttons are for quick shortcut tasks; the menu options are for complete control. 
 



Watching while you work 

Once you become familiar with the menus and toolbars and general layout of your word processing 
screen, don't stop looking! Keep your eyes open while you work. Watch how the screen changes as you 

type (it'll help enormously if you can teach yourself to touch type; trying to learn a computer while 
laboriously searching the keyboard for the 'ƒ' key is going to drive you nuts). When you click the Save 

button to save your work, take a good look at the Save dialog box and get to know each part of it. When 

you apply formatting to a document to make it look snazzier, watch how the toolbar buttons and the 
ruler reflect the formatting of the part of the document you're working in. 

 

Rule Two: Don't work on an urgent task while you're learning. Learning a new program is a 

process of discovery. You'll learn best if you take your time and reduce the distractions and stresses while 
you're learning. 

The one worst way to learn a program is to try to produce something you need to do urgently. If you set 
yourself an urgent task, things are bound to go wrong and you'll lose your ability to focus on learning. 

Instead, you're likely to end up cursing the word processor for making life so damn difficult. 
 

Word processing as play 
Treat your first sessions with your word processor as play. Think of something fun or non-urgent you'd 

like to do, and spend lots of time doing it. That way, it doesn't matter if things don't work out as you 

expect or you make mistakes. You can take your time to undo them or start from scratch if you have to.  

If you take away the urgency, you'll find you can wander through all the menu options and click on 
toolbar buttons to your heart's content. 

While you do so, remember to watch what you're doing: you may click a toolbar button and suddenly 
your document looks different (for example, switching from 'normal' view to 'page layout' view in some 

programs gives you a whole different view of your document). 

As long as you notice what you're doing and take your time, you'll be able to retrace your steps and 

recover from inadvertent discoveries. 

In particular, learn to use the Undo button that most word processors have. It lets you undo your most 

recent changes and can be a lifesaver. 

Rule Three: Save constantly. Or, to put it another way: save, save, save, save, save, save, 

save.  

If you save your work early and often it doesn't matter if you mess up. You can experiment and putter 
around exploring your word processor without feeling a mistake will put you back at square one. 

How often is 'often'? Every paragraph is not too frequently. After all, once you've saved your document 
initially and given it a name, saving any changes you make entails nothing more than a quick click on the 

Save button or, in most word processors, pressing "Ctrl" and "S" at the same time. 

A good way to measure whether it's time to save is the 'Agony of Loss' indicator. Take a nanosecond 

every now and then and ask yourself "How upset would I be if there was a blackout right now and 
everything I've just done was lost?". If you wince at the thought, click the Save button. 

 
The trouble with AutoSave 

One thing to watch out for is the automatic saving (or AutoSave) feature you'll find in most powerful 



word processors. This feature automatically saves your work after a given interval. This may seem like a 

neat safety cushion, allowing you to escape disaster even if you don't save the document yourself. 
However, it can be a trap in itself. 

The trouble with AutoSave is it saves your document without asking you. Say you've been working on a 

document and you make a change that messes up all your careful formatting. If AutoSave kicks in at that 

moment, it will save your document in its currently messed-up state. That's not what you want. 

The other trap in AutoSaving is that it doesn't teach you to become a constant saver. Making saving a 
habit will stand you in good stead no matter what program you're using on the computer. And many of 

them don't have an AutoSave feature at all. 

On the other hand, your word processor should also let you create automatic 'backup' copies of files 

you're working on. If something goes wrong with your original document, you can open the backup copy 
and retrieve your work from that. 

If your word processor has these options (check in the manual or online help under 'Saving' or 'backing 
up' or 'AutoSave'), my advice is to turn AutoSave off and turn the creation of backup copies on. 
 
 

Word Processor Common Knowledge 
 

WordWrap 
Word processing programs will automatically wrap the text from one line to the next. So don't hit the 

enter key when you get to the end of the line. Just keep typing and let the computer figure out where to 
break the text. Also, do not separate a word by hyphenating it at the end of the line. If you let the 

computer complete the word wrap function, and you later insert, or delete text, the computer will 
automatically adjust the lines. If you hit the enter key yourself at the end of the line and/or hyphenate 

words and you later add or delete text, your spacing will be messed up causing you a lot of extra work. 

Headers & Footers 

A header is a line or two of text and/or graphics that appear on every page or every section of a 
document. A footer is the same, except that it appears at the bottom of the page. In Word you set up a 

header and/or footer by clicking on View, then Header/Footer, then entering the information you would 
like to have appear. Use headers and/or footers for any page numbers, dates, and/or repeating titles. 

Then when you make any changes to the document, the page numbers and other information will adjust 
automatically.  

Styles/Templates 

Most word processing programs use style sheets, which are sometimes called templates. Basically, a style 

sheet is a form that defines the layout of a document. You specify the size of the pages, the fonts you 
will use, the margins, and other details. Then you create a template with those parameters that can be 

used over and over again. You can define different style sheets or templates for different projects. For 
instance you can use a more informal style for personal letters, and a more formal one for business 

documents. Look up "template" or "style sheet" in your word processing documentation or help file for 
information on how to create these templates.  

Defaults 



Word processing programs use default settings to create documents. Unless you change these settings, 

and/or create and use a new template, every document will be based on these default settings. In 
Microsoft Word, the default template is called the "normal" template. If you find that every document in 

Word uses fonts that are too small, click on "Format," then choose "Font." Change the font size to 
something larger. Then click on "Default," or "Set as Default," and every document that you create 

from then on will use the larger font that you specified.  

Headings 

If you are creating Chapter Titles or other titles in the document, don't just make them bold, centered, 

and/or italic. Instead, give them the same type of formatting by choosing a style and formatting option. 

In Microsoft Word, this style shows up in the Formatting toolbar at the top of the screen. It will say 
something like "normal", or "Heading 1". If you don't see the Formatting area, click on "View," 

"Toolbars," then make sure there is a checkmark in front of Formatting.  

Highlight your Chapter Titles or other titles and choose a format like "Heading 1" or "Heading 2". Then 

when you modify the heading style to suit your needs, all the headings that use that style will be 
automatically updated. (Look in the help menu for information on how to do this.) 

Don't be afraid to play with your word processing program a little. Read the help file.Try different things. 

And don't use your word processing program like a typewriter. It is much, much more powerful than any 

typewriter ever was. 

Editing Your Documents 
There are three essential processes involved in creating any document using a word processor: writing, 

editing, and formatting your document. Most documents you will also want to print out or send to 
someone using e-mail or fax software. 

 
The three processes 

There are three essential processes involved in creating any document using a word processor: writing, 
editing, and formatting your document. Most documents you will also want to print out or send to 

someone using e-mail or fax software. 

 
Writing in this case means typing. The biggest favor you can do yourself is to learn to touch-type. In 

this way, you can concentrate on what's happening on your screen instead of focusing on your fingers 
hitting the keys. If you can touch-type, you'll learn how to use a word processor much, much faster than 

the hunt and peck typist. 

 
Editing a document involves making changes to the words in your document: checking spelling and 
grammar, reordering sentences and paragraphs, choosing the most apt word. 

 
Formatting is the process of making your documents look good: choosing a typeface, adding headings, 

positioning text on the page, applying a consistent style to a document. 

Moving through the processes 

You can move through these processes one by one, first typing your words, then going back and making 

any changes to the text or spelling or sense of the words, and finally applying formatting to the whole 

document.  



More often, though, you'll find yourself doing all three at once – correcting spelling as you type, italicizing 

words for emphasis and so on, and then doing a final edit and format once you've completed the content 
of your document. 

We're going to focus on the first two processes – writing and editing – in this article. 

Remember the 3 rules! 

Remember, whichever part of the word processing cycle you're focusing on keep in mind the three basic 

rules we covered in the first part of this series:  

1. Read the screen carefully at all times and notice what's happening there.  
2. Take the pressure off yourself while you're learning by working only on non-urgent tasks.  

3. Save your work constantly.  

Getting words on 'paper' 

How do you get your words on paper – or, more correctly, on screen?  

It's a simple matter of opening a new document and typing. 

Almost all word processors start by presenting you with a blank document when you open them. If you 

don't have a blank document open, you can create oneby clicking the File Menu and choosing New from 
the menu. 

The File, New option may give you a choice in the type of new document you create. Simply choose 

'blank' document or 'start from scratch' or a similar option – the exact wording is different from one word 

processor to the next. 

The insertion point 

With a blank document open, you'll see there's a flashing vertical black line near the top of the document. 

This is called the 'insertion point', and it indicates the position where text you type will appear in the 
document. Because this is a blank document, it's right at the top of the page. As you type, you'll notice 

the insertion point moving to indicate where the next text you type will appear.  

Type in a paragraph to test things out. If you've had experience using a typewriter, there's one thing 

you'll need to keep in mind when using a word processor: you do not need a carriage return to start each 
new line. The word processor will automatically 'wrap' the current line round onto the next line, adjusting 

to the margin set. There's no need to hit the Enter key (occasionally labeled Return on some computers) 
until you come to the end of a paragraph. 

A test paragraph 
So, try typing the paragraph below, and observe how the word wrap feature works and how your words 

appear in the word processing window. Don't worry if you make spelling mistakes or other errors. You 
can go back and correct those later. 

By the way, if you're not familiar with typing on a keyboard, to capitalize a letter, hold down the left or 
right Shift keys and press the letter; to capitalize a string of letters, press the Caps Lock key once, type 

the letters, and then press Caps Locks to return to lowercase. 



Here's the paragraph: 
 

I've been spending a little time in San Francisco. The first thing I noticed is how much better the public 
transport is there than in Los Angeles. BART is not bad at all. Thank goodness, because many places in 

the US you are forced to use a car to get around at all. 

Once you've finished typing the paragraph, press Enter to begin a new paragraph. 

Save your work 

Now is a great time to save your work for the first time, too. To save it, click the Save icon in the toolbar 
or open the File Menu and select Save.  

When you save the document, you'll give it a name and when you return to the word processing window, 
you'll see that name in the title bar at the top of the screen. 

Editing the text 

Let's try editing the text. Not everyone knows what BART is, so we're going to insert the words 'Bay Area 
Rapid Transit' in parentheses after BART. To do that:  

1. Use the arrow keys to move the insertion point so it's positioned immediately after the 'T' in BART. 
(You may need to press the Num Lock key if you find the arrow keys are inserting numbers into your 

document instead of moving the insertion point.)  

Most word processing programs will let you move the insertion point faster if you hold down the Control 
key (usually labeled 'Ctrl') at the same time as you press the arrow keys. Standard shortcuts are Ctrl-Left 

Arrow or Ctrl-Right Arrow to move the insertion point a word left or right at a time; and Ctrl-Up Arrow or 

Ctrl-Down Arrow to move to the beginning or the end of a paragraph, or the beginning or end of a page. 
You'll also find the PgUp and PgDn keys will move you quickly from top to bottom of a screen, once 

you've typed a little more. 
 

2. Once you have the insertion point positioned, type: 

 
(Bay Area Rapid Transit) 

Typing modes 

Notice how the words to the right of the insertion point shift over as you type? There are two typing 
modes in word processors: insert, which is the standard mode and which you've just seen in action, and 

overwrite. In overwrite mode, anything you type will write over – obliterate – text to the right of the 

insertion point.  

You can switch between modes by pressing the Ins or Insert key on your cursor control pad (below the 
arrow keys). 

Writing more 

Continue typing another three paragraphs, pressing Enter at the end of each paragraph:  



To tell you the truth, I've had enough of driving. I drove sixteen-and-a-half hours straight, mostly in rain, 

down the I5 to get to San Francisco from Seattle. Most of the drive is boring, except for the stunning 
stretch from central Oregon south to northern California. 

However, despite the driving overkill, I'm looking forward to the drive back. This time I'll take the coast 

road, which is much longer, but which is so beautiful I don't care how long it takes me. I'm hoping to 

spend a week on the road for the return trip. 

So, while I'm in San Francisco, I'm sticking to BART and shank's pony! 

Inserting text 

It appears we're writing a letter, but we've omitted the salutation at the beginning. To insert that, use 

the arrow keys to move the insertion point to the very beginning of your document.  

You've already seen how easy it is to insert words. Inserting a new line or paragraph is just as simple: 
make sure the insertion point is positioned immediately before the first word in the first paragraph and 
then press the Enter key. The whole paragraph will move down one line. You can then press the Up 

Arrow key once to move up to the blank line you inserted, and type: 

Dear Eamon, 

If you find you accidentally insert too many blank lines, press the Backspace key to delete the extra blank 

lines and move your insertion point upwards. (Note: the Backspace key deletes characters to the left of 

the insertion point; the Del or Delete key deletes characters to the right of the insertion point.) 

Now, use the Down Arrow key or PgDn key to go to the very bottom of your letter. If the insertion point 
won't move past the last word in the final paragraph, press Enter to move onto another line. 

Type: 

More later! Lots of love, 

Ray 

Fixing Mistakes 

You've finished the core of your letter. It's now time to read through and correct any mistakes.  

Before you read through, you might want to use your word processor's spelling checker to correct any 

spelling mistakes you've made. Each spelling checker works slightly differently (and some cut-down word 
processors don't even have one). There should be an icon for the spelling checker in the toolbar, or you'll 

find it as an option in an Edit, Tools or Proofing Menu. 

 

Cleaning up after the spelling checker 
Don't depend on the spelling checker to catch all your mistakes. For example, in the second paragraph 

you might have typed 'strait' instead of 'straight'. The spelling checker won't pick it up, as 'strait' is a 

word in its own right. A grammar checker should pick this up, but using a grammar checker on a short, 
informal document like this is probably overkill (and, besides that, they're not always accurate!).  

You can turn 'strait' into 'straight' by using the arrow keys to position the insertion point immediately 

after the 'I' and typing 'gh'. An easier way to do the same thing is to use the mouse to move the insertion 



point: simply click immediately after the 'I' and then type 'gh'. You'll find there are almost always two or 

three ways to perform the same task in a word processor – choose the way that suits you best, but 
remember to look for the shortcut routes. 

Editing alternatives 

Notice how, in both the second and third paragraphs, you've used the word 'stunning'. Eamon's going to 
think you have a limited vocabulary if you keep repeating yourself, so let's change the second 'stunning' 

to 'beautiful'.  

Here are three ways to do the same task: 
 

1. Position the insertion point immediately after the word stunning (using the mouse or arrow keys), 
press backspace eight times to delete the word, and then type 'beautiful'.  
 

2. Position the insertion point immediately after the word stunning, hold down the "Ctrl" key and press 

"Backspace" to delete the word in one go, and then type 'beautiful'.  
 

3. Double-click on the word stunning to highlight (also called 'selecting') the word. Now, type 'beautiful'. 

The word you type will replace the highlighted selection.  

You can use any of these techniques (they should all work in any word processor), but the third 

technique is the fastest of all. 

Selecting text 

The technique of selecting text mentioned in point three above is very important in word processing. 

You'll use it constantly when you are editing and formatting text. At times, you'll want to select a single 

word. Other times, you may want to select a sentence, a paragraph or a whole document.  

The standard text selection procedures are the same in all word processors: double-click a word to select 
it; or click-and-drag over text to select a whole series of words, lines or paragraphs. 

Other selection options vary between word processors. For instance, you can select a whole paragraph in 
Microsoft Word or WordPad by triple-clicking anywhere in the paragraph. To achieve the same effect in 

Microsoft Works 4, you double-click in the margin beside the paragraph. In Lotus WordPro, you hold 
down the Ctrl key and double-click anywhere in the paragraph. 

Discovering editing shortcuts 

How do you discover all these shortcuts? Well, you can try the fun way and experiment: click, double-

click and triple click all over the place. Hold down the "Ctrl" key and do all of the preceding, or try 
clicking with the right mouse button. Don't worry if something unexpected happens: you've saved your 

work (right?) and you're not working on a document that matters anyway. You can always use the Undo 
option on the Edit Menu (in most word processors) to undo your last action as well.  

Alternatively, you can be more orderly and open the Help Menu, look at Help topics or Contents, click the 
Index tab (if you're using a Windows 95 word processing program, or use the Search option if you're 

using a Windows 3.1x program) and do a search for 'selecting text', 'text selection', 'keyboard shortcuts' 
or 'mouse shortcuts'. That should turn up a whole pile of useful shortcuts for you. 

 
Tidying up 



Once you've read through your document and made all the changes necessary, save your document once 

more.  

Our letter doesn't look much at the moment, but we'll go into formatting shortly. Right now, you've 
learned the basics of creating a new document, typing in text, editing your work to correct mistakes and 

make changes, and saving your work. 

Reorganizing Your Words 

Word processing programs are extraordinary time savers. While you're in the process of learning how to 

use such a program, you may beg to differ. You may feel that writing a letter or essay by hand is 
infinitely easier and faster than struggling with all the icons and views and menus. 

Maybe so, but once you're past the first stage of learning the basics of your word processor, you'll find 
almost every aspect of creating a written document is much, much speedier and more efficient using a 

word processor. 

 
Writing the old way 
Take essay writing. If you've ever had to write a long essay by hand or with a typewriter, you'll be 

familiar with the process. It goes something like this: 

 Jot down an outline of what you want to say.  

 Write a first draft, perhaps leaving those difficult first and last paragraphs in an embryonic 

form, so you can work on them in the next draft.  

 Read over your first draft, decide that paragraph C should be swapped with paragraph K and 

notice all the misspellings and word usage you want to change.  
 Write a second draft, which you're hoping will be the final draft, so you agonize over that first 

paragraph and try to get everything just right.  

 Read through your second draft and realize that paragraph C looked better in its original 

position, you left out one key reference entirely, you've missed two spelling errors and you're 

still not happy with your first paragraph.  
 Write a final draft, read it over and use white-out on the remaining spelling error.  

Does that sound at all familiar? I can still remember the ache in my hand from going through this process 
on a 10,000 word essay. 

 
Writing the new way 

A word processor eliminates almost all the hard work in this process, leaving you to concentrate on the 
important part: getting your ideas across clearly. With a word processor the process goes like this: 

 Jot down an outline of what you want to say.  

 Expand on each idea, using your existing outline as headings or paragraph lead-ins, creating 

a first draft. You don't worry too much about the opening paragraph as you know you can 
come back and insert it at any time you feel inspired.  

 Run the spelling checker through your document, read through your first draft, click and drag 

paragraphs C and K to their new locations, and change words you don't like.  
 Read your draft again, swap paragraphs C and K again, and finalize your opening paragraph.  

Instead of writing three (or more) drafts, you've written one and then tinkered with it to your heart's 

content. Right up to the last instant before you print it, you can make small or large changes with little 
effort. 



The key to it all is the in-built editing features of your word processor. 

Selecting text 

In the previous article in this series, you learned the basic steps involved in word-by-word editing: how to 
move around your document, change a word here and there, select words, sentences and paragraphs.  

There's more to editing than changing an occasional word, of course. In the essay example above, much 
of the editing process involved restructuring the essay, moving whole paragraphs, and inserting large 

chunks of text. All this is painstaking by hand or using a typewriter but beautifully simple using any word 
processor. 

Familiarizing yourself 

Becoming familiar with selecting text is crucial to making any changes to your document, whether those 
changes are editing or formatting (changing the look of the document): first you select the text, then you 

replace it, cut it, copy it, move it, delete it, or change its appearance.  

You learned the basics of selection in the last article: you click and drag across text to select any amount 

of text, from a letter to a whole document; double-click a word to select it. Each word processing 
program has additional shortcuts for selecting anything from a sentence to a paragraph to an entire 

document. 

The case of the disappearing text 

One of the most important things to remember is that if you have text selected in your document, typing 

anything on the keyboard will replace the selected text. This is one of the traps that catches beginners all 
the time.  

For instance, say you select the first paragraph in your document, planning to move it down below the 
second paragraph. Before you get a chance to do that, you accidentally tap the Spacebar. Your first 

paragraph will disappear in a flash, replaced by a single space. It's no big deal as long as you keep your 
wits about you: just click the Undo icon or choose Undo from the menu. Watch out for this – it's easy to 

select some text and then type something without realizing you're replacing existing text. 

Why does selection work like this? So it's easy to change text to something else. Often, you'll want to 

replace a word or phrase: all you need to do is select the phrase and type your replacement text, a nice 
quick two-step process. 

Watch for the highlights 

This works in any Windows application and in Windows dialog boxes as well, so take notice of it. If you 

have a dialog box in front of you, notice if any text is selected (highlighted). If it is, there's no need to hit 
Delete or Backspace to get rid of it, just go ahead and type.  

Equally important, if you don't want to replace the selected text you need to click somewhere in the 
document or dialog box to deselect the text. (Clicking in a blank space on your page is a useful trick not 

only for deselecting text but also for closing a menu you've accidentally opened.) 

The Clipboard 



A lot of the changes you'll make to documents will involve deleting, copying and moving text. Windows 

makes this process easy by providing a feature called the Clipboard. The Clipboard is a space in your 
computer's memory for storing data (slabs of text, spreadsheet figures, graphics) temporarily.  

Try this:  

1. Open a document.  
2. Write three or four sentences.  

3. Highlight the first sentence and choose "Cut" from the Edit menu (or click the "Cut icon" in 
your word processor's toolbar).  

The sentence will disappear from your document.  

4. Now, click immediately before the third sentence to position the insertion point there and select Paste 

from the Edit menu, or click the "Paste" icon on the toolbar.  

The sentence you deleted will reappear at your insertion point, moving the third sentence over to make 
room. Check that there's still a space between the sentence you inserted and the third sentence: you 

may need to insert a space manually, although some advanced word processors are smart enough to do 

this for you. 

This is the usual process for moving text in a document. You:  

1. Select the text  

2. Cut it  
3. Move the insertion point to the new position.  

4. Paste the text.  

If you want to copy a piece of text instead of moving it, use "Copy and Paste" instead of "Cut and 

Paste." 

 

Where'd the text go? 
The text you cut is placed on the Clipboard, available to be pasted anywhere in your current document, 

another document or even in another program altogether. The Clipboard holds one item at a time: 
anything you cut or copy to the Clipboard will remain there until you cut or copy something else. This 

means you can Cut an item to the Clipboard and then Paste it multiple times.  

Remember, you have to use the Cut or Copy commands to place text on the Clipboard. If you highlight 

some text and press Delete or Backspace to delete it, the text will not be placed on the Clipboard, it will 
simply disappear. 

 
Moving and copying text 

You can probably see how useful Cut, Copy and Paste can be in restructuring a document. These 
commands are also terrific for moving or copying information between documents. Because Windows 

supplies a single Clipboard for all the applications you run, anything you copy to the Clipboard from one 
program will be available to any other Windows program. So, for example, one way to place a graphic in 

your word processing document is to: 

1. Open a graphics program and create a graphic.  

2. Select the graphic and Copy it to the Clipboard.  
3. Open your word processing program, position the insertion point and click the Paste button.  



Similarly, you can copy text from one document to another by opening the first document, selecting the 

text, clicking the Copy button, opening the second document, positioning the insertion point and clicking 
Paste. 

Dragging and dropping 

Cut, Copy and Paste are great techniques to master because they are universal. Once you learn these 
techniques, you can use them in any Windows program worth its salt.  

If you want to be more efficient, most new word processors offer an even simpler technique for moving 
of copying text within a document: drag and drop. With drag and drop you don't need to use the 

Clipboard. Instead, you:  

1. Select the text you want to move.  

2. Position your cursor so it's within the selected text. The cursor will change shape – to an 
arrow-head pointing towards the left margin in Microsoft word processors (in Microsoft Works 

you'll see the word 'drag' beneath the cursor), to a little hand in Lotus programs, and so on.  
3. Hold down the mouse button and drag the text to its new position, then release the mouse 

button.  

Simple, huh? 

If you want to copy the text rather than move it, hold down the Ctrl key while you click and drag the 

text. 

Dragging between applications 

In Windows word processors, this process of drag and drop even works between applications.  

For instance, you can open up your word processor and, say, your e-mail editor, right-click in a vacant 
space on the Windows Taskbar and choose Tile Vertically or Tile Horizontally to position both windows 

side by side, and then click and drag selected text (or "Ctrl-click" and drag it to copy it) from one 
window to another. 

Coming up 

By now, you should have all the basics of editing documents under your belt. You should be able to:  

 enter text  
 move around your document using the arrow keys, Ctrl-arrow combinations or the mouse  

 insert text and correct errors  

 select, replace, delete, move and copy text  

 move text or other items from one document to another using the Clipboard.  

The next step is to make your words look good. This involves using the formatting tools of your word 
processor: setting tabs and margins, changing the style and look of the typeface you use, positioning text 

on the page. That's what we'll do in the next article in this series. 

In the meantime, remember to watch what you're doing, practice new techniques on non-urgent 

documents, and save your work often. 
 



 

Formatting Your Documents 
Getting your words down on 'paper' is only part of producing a document. Just as important is making 
your document look good. A well-formatted letter, report or memo is easier to read, draws attention to 

the most important information, and creates a receptive and favorable impression in the reader.  

"Word processors provide you with the tools to make your documents look good. They can't give you 

taste and a sense of style – although some of the upmarket word processors can automatically apply 
consistent styles to your documents to make them look smart – but they do supply you with everything 

you need to take your words from raw text to stylish output." 

Text Formatting 

Most word processor users spend far too much time on the details of formatting. Following a few simple 
rules can make life easier. 

Your document is something to be read, not put on a wall and admired for its artistic 

qualities. Concentrate on making it readable, not beautiful. On the other hand, a 

badly-formatted document is harder to read, and may annoy the reader.  

Unless you have a very good reason for doing otherwise, use one font for the whole 
of your document. Having a lot of different fonts makes things confusing for the 

reader, and wastes your time into the bargain. Use a standard font (e.g. Times 

Roman) in a normal size (e.g. 11 point).  

For term papers, essays etc., double-space the lines and make sure the paper 
margins are wide enough for the reader to be able to write comments.  

In general, you should only use bold for headings. Use italics for emphasis, for titles 
of books or for foreign words (remember that Turkish counts as a foreign language 

here!). As you can see from this paragraph, using bold normally makes a word stand 
out too much.  

Keep tables simple. Using a lot of colors and patterns only distracts the reader. 
Similarly, only use borders and boxes if they are really necessary.  

Leave one space after commas, colons and semi-colons, and two spaces after the end 
of a sentence (unless you're using a program which does this automatically, such as 

LyX).  

If you are submitting a paper, find out if the person you are submitting it to has any 

special requirements. They may, for example, want you to number section headings, 
or conversely not to use section headings at all. Normally a cover page is required; 

find out what information needs to go on it and how it should be laid out.  

 

File Formats 

An irritating feature of word processors is that they all have their own formats for saving files. Not all 

word processors can read all file formats, so be careful which format you save in if you want other people 
to be able to read your documents, or if you want to use your own document with a different program. 



Use the ``Save as'' or ``Export'' commands from the ``File'' menu to see what formats are available. 

You can normally tell what format a document is in by looking at the part of its name after the dot. Some 
common formats are as follows:  

[.doc] Microsoft Word Document. Only really suitable if you are only going to use it 
with MS Word; some other word processors can read it, but they usually lose some 

formatting in the process (particularly tables and quotation marks). Moreover, there 
are different versions of the .doc format, so, for example, you may not be able to 

read Word 97 documents in Word 6.0. Another problem is that it is vulnerable to 
macro viruses (e.g. the notorious ``Love Letter''). Never send or open e-mail 

attachments in this format.  

[.txt] Plain Text Format (ASCII). No formatting at all really, but very compact. Can 

be read by any word processor, or inserted into e-mail.  

[.rtf] Rich Text Format. Sort of half way between plain text and Word Document. Has 

some basic formatting (e.g. italics). Not sophisticated, but can be read easily by many 
processors.  

[.html] HyperText Markup Language. This is the standard format for web-pages, but 

can also be used by and for word processors, so it makes quite a good lingua franca 

between different programs.  

[.pdf] Portable Document Format. Useful for putting long documents on the web or 
sending them via e-mail; however, it can't normally be edited, so you would normally 

only use this for distributing your final version. It needs a special program (e.g. 

Adobe Acrobat) to read it.  

[.ps] PostScript. Used mainly for sending files to printers. It can also be viewed using 
programs such as Ghostview, but can't be edited unless you are prepared to spend 

years learning how to do it.  

[.tex] TEX, a typesetting format which is useless in itself, but can be converted easily 

into other formats such as PostScript, PDF, RTF or HTML.  

Other formats, such as .lyx, .kwd, .sdw and so on, are only used by one particular word processor, and 

therefore need to be converted into something else if you want other programs to be able to read them. 

Clean and consistent 

Making your documents look good can be as simple as making your headings bold or positioning 

addresses and salutations correctly in a letter. It can be much more than that, too, but when you're first 
starting out it's far better to aim for a clean, simple, consistent look to your documents than to try to 

achieve the ultimate in style. Of course, the ultimate in style may well resemble the clean, simple 

consistent look you aim for in the first place.  

In fact, the most frequent mistake made in formatting documents is to try to do too much: apply multiple 
styles, use half a dozen fonts, go for fancy layout. 

Instead of going for broke, take a look at your document, decide which elements you want to emphasize, 
and assess how formal the document needs to be. Then do the minimum amount of formatting required 



to achieve your ends. 

 
How formatting works 
As with most word processing tasks, the first step in formatting text is selecting the text you want to 

format. Decide which text you want to change, select it, and then apply the appropriate formatting.  

Some formatting is applied to your whole document (such as page margins), but most is applied to 

specific portions of text. 

You'll find most essential formatting tools on your word processor's toolbars and the ruler. Formatting 

controls include:  

 bold  

 italic and underlined text;  

 alignment tools;  

 font size and typeface;  

 indentation;  

 tab settings;  

 margin settings.  

If you want more control, you may need to use the menu equivalents of these toolbar options. Look for 
extended formatting tools in a menu named Format or Text (Claris Works breaks it up into Format, Font 

and Style menus). 
 

Formatting as you go 

If you apply formatting after you've completed typing a document you'll find it easy to identify which 

sections of text are being affected by a particular style of formatting. Things can get a little more 
confusing if you format as you type. For instance, try this: 

1.   Type two paragraphs.  

2. Select both paragraphs and then click the Italics button (usually an italicized I ) on the 

toolbar.If your word processor doesn't have an Italics button, look for this option under a 
menu called Style, or under a Font option on a menu called Format. This will italicize the 

selected text.  
3. Now, click immediately at the end of the first paragraph you typed, and press Enter to begin a 

new paragraph.  

4. Start typing.  

What happens? 

The new paragraph you type between the two paragraphs is also italicized, even though you didn't select 

it and format it with italics. This is because information about the formatting for each paragraph is stored 
in an invisible 'paragraph mark' at the end of the paragraph. If you press Enter, you 'carry over' the 

existing formatting onto the next line or paragraph. 

Carry over formatting 

This makes sense: you can start a document, format the first paragraph, and then have that style carry 

over for the rest of the document, including margin indents, typeface and so on.  

However, it can also cause you problems if you don't keep your eyes peeled. It's very easy to end up with 
carry-over formatting and not know why your paragraph is, for example, appearing centered on the 



page. You can check the formatting on particular paragraphs by clicking in differently formatted 

paragraphs in your document: you'll find that the ruler and toolbar icons change to reflect the formatting 
of the current paragraph. The ruler will show the tab settings and indents for the current paragraph; 

toolbar buttons such as the alignment buttons will appear 'depressed' if they're currently in effect. 

Let the program do the work 

Most newcomers to word processing make work for themselves by failing to comprehend the amount of 

work the word processor can do for them.  

The whole point of using a word processor is to let it do as much of the work as possible, freeing you to 

focus on your words and the overall look of the document. 

Avoid the Enter key 

One common error is to space paragraphs by pressing the Enter key twice. There's no need to do this, as 

the word processor provides an alternative way that gives you much subtler control over the look of your 
document.  

To space paragraphs using (almost) any word processor, use this method:  

1. Type your document, pressing Enter once at the end of each paragraph.  
2. Select all the paragraphs in your document and then use the Format Paragraph option to 

adjust the spacing after each paragraph. For example, in Microsoft Word, open the Format 

Menu, choose Paragraph, and then adjust the Spacing After to 6 points. In Microsoft Works, 
open the Format Menu, choose Paragraph, click the Spacing tab, and set the Spacing After to 

0.5 li (that's half a line's worth of spacing). In Claris Works, choose Paragraph from the 
Format Menu, in the Space After box type 6 and in the box beside it, select Points from the 

list. (Don't try to type 0.5 lines for your spacing in Claris Works – it will appear to be a valid 

value, but it won't work.) You'll find similar options in WordPerfect, Ami Pro, Word Pro and 
many other word processors.  

Avoid the Spacebar 

  The overuse of the spacebar is really the biggest mistake of most novices. Because the computer uses 
better spaced fonts than a typewriter, extra spaces after sentences are not needed. There should be no 

extra spaces after colons, semi-colons, etc. 
 

Most importantly, never use the space bar to move text over on the page. If you want the text to be 

centered on the page, let the word processing program center it for you. Most programs have an icon on 
the Formatting toolbar at the top of the page that will center the text automatically. Then if you change 

the size of the page the text will still be centered. If you want to indent the first line of a paragraph, use 
the tab key not the space bar, or set up a paragraph with a first line indent. 

 

If you would like to create text or numbers in columns, again, don't use the space bar to move the text. 
Instead set tab stops by clicking your mouse in the ruler at the top of the screen. There are several 

different types of tabs that can be used. Read the word processor's help file to learn how to use them. In 
a program like Word you can also create columns automatically. Choose format, then Columns, then fill in 

the information requested to create the columns of the size and type to fit your needs. 
 

This is a common error in the way people use word processors is to align text by using the Spacebar, 

instead of using tab stops or ruler settings.  



  For instance, take a look at the text in the following screenshot: 

Figure 1: Aligning text using tabs 

 

See how it contains a list of items, neatly aligned in columns? 

A common beginner's approach to creating such columns is to type a word, press the Spacebar multiple 

times to position the next column, type the next word, press the spacebar again and so on. On the next 
line, they try to align words under the existing text by repeatedly pressing the Spacebar again. 

Proportional and monospaced typefaces 

Not only is this incredibly tedious and wasteful of your time, it also won't work.  

Most word processing typefaces are proportional , meaning each character is a different width (contrast 
this with monospaced typefaces, where each character – such as M and I – occupy the same width). 

For example, contrast the word smile in the proportional Times New Roman font with the same word 
printed beneath in the monospaced Courier New font: 

smile 

smile 

See how each character is a different width in the proportional font – making it very space efficient, by 

the way. The monospaced font has no such elegance. 

So, trying to type words and then fill the gaps between them with spaces will lead to uneven alignment. 

The ruler 

Word processors offer a quick, neat way to align text using tabs . In most word processors, you have 

enormous control over tab settings, allowing you to create aligned text very rapidly.  

Most word processors have a ruler which lets you set indentation, margins and tab settings. You'll usually 
find it situated near the toolbars at the top of the page. 

The ruler, like the toolbars, provides single-click shortcuts to controlling the most common elements of 

paragraph indentation and tabs. If you need additional control, you'll need to check out options on the 
Format or Text menus, which will give you greater control. 



Using the ruler 

Use tabs when you want columns of words or numbers to be aligned. You can also use tables to do this 

task, but not all word processors support tables, and tabs are usually less complex to work with.  

To use the ruler, first select the paragraph(s) you want to format, then make the appropriate 

adjustments to the tab settings, indents and margins. You can then select another paragraph and apply a 
different group of settings if you wish. 

Have a look at the screenshot below. It's similar to the previous screenshot, but highlights the features of 
Microsoft Word's ruler. While not all word processor rulers are the same, you'll get a good idea of what's 

possible by examining the Word ruler. 

Figure 2. Features of the Microsoft Word ruler 

 

A. Tab style selector: click to select between left-aligned, right-aligned, centered or decimal tabs. 

B. Left indent marker: Click and drag to indent the second and subsequent lines in a paragraph. 
C. Indent box: Click and drag to indent a whole paragraph. 

D. First line indent marker: Click and drag to indent the first line of a paragraph. 
E. Decimal tab: To position a tab, first use the tab style selector at the left end of the ruler to choose the 

type of tab you want, then click on the ruler to position a tab. The decimal tab is used to align numbers 

on their decimal point. 
F. Left-aligned tab: This is the 'default' tab style, aligning text flush left with the tab position. 

G. Right indent marker: Click and drag to change the right indent of all lines. 
H.Notice the first-line indent on the paragraph created by moving the first-line indent marker to the right 

on the ruler. 

I. The numbers are aligned around their decimal points, in line with the decimal tab on the ruler. 
J. This last column is left-aligned with the final tab placed on the ruler. 

Readability is the rule 

You'll find most simple formatting controls straightforward to use. Probably the key thing to keep in mind 
– other than not going overboard with all this power at your fingertips – is to remember that the key 

purpose of almost any document is communication. Therefore, any formatting you apply should go 
towards increasing the readability of your document.  



Don't get caught up in too many other 'rules'. For example, many people believe you should justify 

paragraphs in letters (justified paragraphs are spread across the page so the right and left margins are 
both perfectly even). This looks fine when you're working in columns – as in magazines or newspapers – 

but doesn't work so well on wider expanses, as you end up with uneven gaps between words that 
actually decrease the legibility. 

We tend to get taught a whole bunch of rules about formatting documents such as letters – where the 
address should go, where your signature should go, and so on. Don't fret too much about these things. 

Instead, take a good look at your page and see just how balanced it looks, how readable it is. 

Pre-designed styles 

If you're really wanting to make a good impression and don't trust your own judgment, you'll find most of 

the good word processors (including Microsoft Works and Claris Works) come with a range of pre-written 
templates (aka wizards, experts, tutors and various other names). You can use these templates as 

guidelines for creating your own letters.  

Even if you want to do your own work from scratch, taking a look at some of these templates will give 
you an idea of what's possible and what makes good formatting sense. 
 

Useful tips 

Find out which things your program can do automatically (lists, styles etc.). For example, this list was 

produced with a style called "enumerate'' - We didn't need to put in any of the numbers or spaces 
ourself. If necessary, find out how to stop it doing things (look for a menu entitled "Options'', "Settings'' 

or "Preferences''). Many features are useless or annoying (e.g. changing (c) to a copyright sign).  

Get to know your keyboard, especially how the Ctrl, Shift, arrow and page keys work (e.g. in most 

programs hitting Shift-End will block all text to the end of the line). Find out what the Alt or Alt Gr key 
does in combination with other keys; you may not have realized that your keyboard can produce 

characters like Ã¢ or Ã®, for example. Learn the most common key-bindings ("hot-keys''), e.g. Ctrl-B for 
bold, Ctrl-S for Save etc. Remember that when you are typing, your hands are on the keyboard, not on 

the mouse.  

Unless your program handles indentation automatically, use the tab key or the rulers to indent text, 

rather than hitting the space bar repeatedly. Check to see if it has predefined styles for things like 
blockquotes.  

When you start writing an essay, it's often a good idea to copy the main items in your outline into your 
essay as section headings. This will save you time later, and reminds you to keep to your plan. If your 

program doesn't have a predefined style for section headings (or you don't like the one it has), put them 
in bold, and make the font size slightly bigger than the rest of your text.  

While writing, save regularly - don't trust the "Autosave'' feature. In most programs, all you need to do is 
hit "Ctrl"+"S", so do it after each paragraph. Make a backup copy when you finish: "My computer had a 

virus'' is not a very good excuse for not submitting work.  

Use a spellchecker if your program has one, but do not trust it. Many words you use will not be in the 

computer's dictionary, and some words may be in the dictionary but have the wrong spelling for that 



context (e.g. "effect'' instead of "affect''). Never use the "Change all'' or "Replace all'' option - you may 

end up changing words that are actually correct, or correcting them in the wrong way.  

Do major formatting, such as page breaks, right at the end - you don't want to have to keep changing 
things. If your program has a print previewer, use it to make sure your document looks OK before you 

print it out.  

After you print your document, read it again. Sometimes you miss mistakes when you're looking at a 

computer screen, but you notice them when you see them on paper.  

7. Practice and a Quiz 
Giving you this tutorial was to let you get your feet wet, so-to-speak. Learning your word processor can 
prove to be one of the best things you can do for a work-from-home experience. There are so many jobs 

that cannot be filled due to the lack of qualified people who are able to do some of the things we have 

shown you.  
 

Practice, Practice, Practice 
You will need to use your word processor as often as you can to get thoroughly familiar with it. We 

suggest you start creating anything, and everything you can with your word processor. For example, you 
can create your own business cards, Christmas cards, fliers for a party you may be having, event 

calendars, and you can start inputting your personal finances onto spreadsheets. Anytime you use your 

word processor you will get better and better.  
 

Quiz 
We have a 20-question quiz for you to take if you choose. This may help guage you knowledge of your 

word processor. Click the link below to take the quiz. If you score 90% or better, you have a pretty good 

grasp on how your word processor works. If you are below 50%, you may want to go back through and 
take a refresher on this course.  

 

CLICK HERE TO TAKE QUIZ 

 

8. Data-Entry Jobs & Assignments 
Now it is time to get to work with all the knowledge you have gined from this training. In this section we 

are going to explain all the job opportunities that will earn you money working at home doing any of the 

many different data-entry jobs available through our program. 
 

There are four primary job opportunities we will present, and here they are:  
 

A. Outsource Agencies 
We will list many outsource agencies which will send you work directly. You simply provide them with 
your information, demographics, etc.  The outsource agencies will act more of the "middle man" dealing 

with many of the large companies needing work done. They will then send you the work directly to you. 
The main requirement is knowing how to use a word processor, and with the training you have just 

received you are now qualified to deal with these agencies. 

 

B. Job Board 
On our data-entry job board we list several companies, individuals, and current job assignment postings 
that are in need of your data-entry services. We have designed a unique way to get up-to-the-minute 

jobs assignment postings. We will give you more details in our job board section on how you will get the 

assignments directly from the source.  

http://www.academictutorials.com/quiz.asp?id=160


 

C. Contracted Work 
One of the best opportunities to get data-entry jobs is to use a service we deal directly with. These 

contract companies will post hundreds, even thousands of current projects, and all you have to do is bid 
on how much you are willing to get paid to complete the job. If the person posting the job accepts your 

bid, then you get the job. You do not need to post a resumé etc. Just take a look at the job assignment 

requirements, then bid what you want to charge to complete it.  
 

D. Your Own Business 
If you choose, starting your own outsource data-entry business can be very easy to do. The best way to 
do this is to create your own blog page to promote the services you provide. Here you can give details on 

your service specialty or specialties. If you go to the "HOME TYPING" program we offer you will see a 
complete tutorial on how to set up a blog for free. You can then simply print some business cards, fliers 

etc. listing your blog page URL address and promote your business locally or online. This is really an 
addition to the jobs and assignments we offer, but can open up some real good opportunities. 

 
 

A. Outsource Agencies 
We have listed in this section a large amount of outsourced data-entry jobs opportunities through special 
agencies. The job descriptions can vary from data processing, clerical duties, and virtual office 

assistance. These companies specialize in outsourcing work directly to you. 
 

Remember the following jobs will need you to fill out thier processing application to receive work.  

 
NOTE: All of the agencies we list are FREE as they will be paying you - If you find any of the 

following agencies asking for additional money please report them to Support@Global-Data-
Entry.com or MyDataTeam@Yahoo.com and we will remove them. Some agencies change their 

terms which we do not have control over, but we will remove them from our program if they charge for 
anything. 
 

DION DATA SOLUTIONS 

Must type at least 55 wpm with accuracy. Computer Skills including internet, e-mail, e-mail attachments, 
downloading and uploading files. Ability to work independently.  

THE APPOINTMENT BIZ 

Virtual Assistants. Working out of a home office setting appointments and entering various data entry 

tasks. You apply by email to: resume@theappointmentbiz.com. 

VIRTUAL CUSTOMER SUPPORT 

Customer service interaction via email, telephone, and live support from their website. Administrative 
services such as: Updating spreadsheets, data entry, providing daily updates of activities, and attending 

weekly team calls. Researching customer issues and resolving them while offering top notch customer 
service. 

KEENE TEAM 

Virtual Clerical Office Assistants.  

AXION DATA SERVICES 
1910 Cochran Rd, Suite 730, Manor Oak 2, Pittsburgh, PA 15220.  

Phone #1-800-493-2630 of #1-412-341-6800.  

Assignments include matching customers addresses to data base reports, email batch reports. These are 
real simple data processing jobs that anyone can do. 
 

mailto:Support@Global-Data-Entry.com
mailto:Support@Global-Data-Entry.com
mailto:MyDataTeam@Yahoo.com
http://www.diondatasolutions.net/opportunities.html
http://www.theappointmentbiz.com/subcontractors.html
mailto:resume@theappointmentbiz.com
http://www.virtualcustomersupportwanted.com/
http://www.keeneteam.net/apply.aspx?step=1
http://www.axiondata.com/Applicant.asp
http://www.axiondata.com/Applicant.asp


XACT SERVICES 

Taking calls in a fast paced, customer driven environment working from your home office. Bilingual a 
plus. Computer and high speed Internet connection required.  

VIRTUAL ASSISTANT JOBS 

Offering a number of work at home positions from no experience to experienced jobs. They also offer 

their own training programs for more advance positions.You may be asked to take a typing test to 
establish your skills level.  

DMC OFFICE 

Seeking work at home contractors for various job duties: word processing, Data Entry, Data base etc. 

Check back if currently nothing is available, they post quite frequently. Should be accepting My-Data-
Team members in May 2011.  

SMITHFIELD ASSOCIATES 

Document Processors - $10 - $13 per hour. The Document Specialist prepares, implements and 

coordinates production projects, which may include but is not limited to financial statements, audit 
reports, proposals, presentations, and template-driven production documents such as nametags and 

brochures. You must be able to email your work as an attachment. For this reason, they prefer applicants 
who do not use AOL or Bellsouth dial up service since these services are problematic with regards to 

email. This professional is responsible for all phases of project management, including customer service, 

text editing and processing, and template formatting. The Document Specialist also produces documents 
in standard formats/templates and custom formats/templates, and prepares files for digital output and 

duplication. The hours for this position are 9am-6pm with overtime required.  

AUDIOLINK 
NY U.S.A Area 

AudioLink offers an opportunity to gain solid experience in a friendly, supportive environment. If you 

have good communication skills, computer knowledge, and/or office experience - this is the right job for 
you.  

 
TEAM DOUBLE CLICK Inc 

Virtual Office Assistants. Virtual Admin, Internet research, Data entry Resume preparation. 
 

B. Job Board Search 
We have listed in this section a large amount of outsourced data-entry jobs opportunities through special 

job boards searches. The job descriptions can vary from data processing, clerical duties, and virtual office 
assistance.  

 

We have a list of up-to-the minute job and assignment postings. Many of these jobs and assignments 
may have been posted in the last few minutes. You can click on any of the cities, states or countries to 

see what is available in your area or view other places for outsourced data-entry jobs and assignments. 
  

Telecommute 

You will see telecommute and in-office jobs. You can search all areas to locate any of the telecommute 
jobs available. Most of telecommute jobs can be performed from anywhere in the world. 

 
Our Search Results 

What we are providing for you is an easy way to get results for "data entry" jobs and income 
opportunities. We do know that all the job search engines we will give you are free to use. The difference 

with our search is that our programmers have re-scripted the job search engines to display instant results 

http://www.xactservices.info/employment/
http://www.virtualassistantjobs.com/jobs.html
http://www.dmcofficeservices.com/emp2.html
http://www.pliner.net/appfs/650e67/
http://www.audiolinks.com/CareerOpportunities.shtml
http://www.audiolinks.com/CareerOpportunities.shtml
http://www.teamdoubleclick.com/freelance.html?step=step1


upon clicking on the job search engine links we provide. This will save you hours having to go to each 

search engine and typing your search and going through the long process of getting results. With our 
search results you can search all the job results in minutes. 

 
Note: Because we do not have control over exactly what assignments and jobs are posted on these 

job search engines, there may be companies that try to sell you something, disregard those postings. 

   

JOB BOARD #1 

Just click the following search icons and search; No sign up needed 

  

  

  

  

  

  

  

  

http://jobs.com/search?q=data%20entry
http://www.indeed.com/jobs?q=data+entry&l=
http://www.careerbuilder.com/JobSeeker/Jobs/JobResults.aspx?SB%3Asbkw=data+entry&SB%3As_freeloc=&SB%3Asbfr=30&sbsbmt=Find+Jobs+%C2%BB&lr=cbc_true&cid=US&excrit=QID=A3849808722836%3Bst=A%3Buse=ALL%3BrawWords=work+at+home%3BCID=US%3BSID=%3F%3BTID=0%3BENR=NO%3BDTP=DRNS%3BYDI=YES%3BIND=ALL%3BPDQ=All%3BPDQ=All%3BPAYL=0%3BPAYH=gt120%3BPOY=NO%3BETD=ALL%3BRE=ALL%3BMGT=DC%3BSUP=DC%3BFRE=30%3BCHL=AL%3BQS=SID_CBC_TRUE%3BSS=NO%3BTITL=0%3BRAD=30%3BJQT=RAD%3BJDV=False%3BExpHigh=gt50%3BExpLow=0%3BMaxLowExp=-1&IPath=JRKV
http://www.thejobbox.com/tjb/JobSeeker/search.cfm?page=position-results&CFID=146679&CFTOKEN=30464349
http://www.careerjet.com/search/jobs?s=data+entry&l=USA
http://www.job-search-engine.com/jobs?k=data+entry&l=United+States
http://www.totaljobs.com/JobSearch/Results.aspx?Keywords=data+entry&Radius=5
http://www.simplyhired.com/a/jobs/list/q-data+entry
http://www.jobvertise.com/jobs/search?query=data+entry&city=&radius=30&state=&button=Search+Jobs
http://seeker.dice.com/jobsearch/servlet/JobSearch?registerRemSw=0&SAVESEARCH=&op=300&caller=2&LOCATION_OPTION=2&AREA_CODES=&ZIPCODE=&RADIUS=64.37376&COUNTRY=1525&METRO_AREA=33.78715899%2C-84.39164034&TRAVEL=0&SORTSPEC=0&FRMT=0&DAYSBACK=30&NUM_PER_PAGE=30&N=1525+0&EXCLUDE_KEY1=&EXCLUDE_KEY2=&EXCLUDE_KEY3=&EXCLUDE_KEY4=&EXCLUDE_KEY5=&EXCLUDE_KEY6=&EXCLUDE_KEY7=&EXCLUDE_TEXT1=&EXCLUDE_TEXT2=&EXCLUDE_TEXT3=&EXCLUDE_TEXT4=&EXCLUDE_TEXT5=&EXCLUDE_TEXT6=&EXCLUDE_TEXT7=&NUM_PER_PAGE=30&EXPANDED_NE=&FREE_TEXT=data+entry&Ntx=mode+matchall
http://jobs.salary.com/Job_Search/searchresults.aspx?JobKeyword=data+entry&Location=&x=48&y=10
http://www.sologig.com/SG/JobSeeker/Jobs/JobResults.aspx?exCrit=QID%3dA6658173066719%3bst%3da%3buse%3dALL%3brawWords%3ddata+entry%3bCID%3dUS%3bSID%3d%3f%3bTID%3d0%3bENR%3dNO%3bDTP%3dDRNS%3bYDI%3dYES%3bIND%3dALL%3bPDQ%3dAll%3bPDQ%3dAll%3bPAYL%3d0%3bPAYH%3dgt120%3bPOY%3dNO%3bETD%3dALL%3bRE%3dALL%3bMGT%3dDC%3bSUP%3dDC%3bFRE%3d30%3bCHL%3dSOLO%3bQS%3dsid_unknown%3bSS%3dNO%3bTITL%3d0%3bOB%3d-modifiedint%3bJQT%3dRAD%3bJDV%3dFalse%3bSSG%3dTrue%3bExpHigh%3dgt50%3bExpLow%3d0%3bMaxLowExp%3d-1&ff=21
http://www.net-temps.com/webapps/search/jobs.do?searchvar_textLoc=&searchTerms=work+at+home+AND+data+entry&indexName=jobs&operator=0&searchvar_locations=&narrow=data+entry&searchvar_daysback=0&x=17&y=13
http://www.jobserve.us/JobListing.aspx?shid=C00C1E442E8BD1E446&tv=0
http://www.glassdoor.com/Job/data-entry-jobs-SRCH_KO0,10.htm
http://www.flipdog.com/results.php?k=data+entry&l=City%2C+State+or+ZIP&x=68&y=20


  

  

  

  

  

 
 

C. Contracted Work 
This may be the best source for assignments. The way it works is people and/or companies will post a 
particular project on the main board, then you can place a bid to complete the work. It is entirely up to 

you on how much you should bid. It is your time that you will put a self worth on. We will suggest to 
start to keep your bids a little lower until you get more experience. Again it is entirely up to you. 

 
You will see thousands of project postings available for you to work with as a contractor. 

 

Using the bid agencies we provide will allow you to find posted projects and bid on the work. If your bid 
gets accepted you do the work. This is the best way for inexperienced data entry clerks to get work. 

 
There are three major agencies we will list: 

ASSIGNMENT BOARDS 

Assignment Board #1 

  

http://www.careerbuilder.com/JobSeeker/Jobs/JobResults.aspx?SB%3Asbkw=data+entry&SB%3As_freeloc=&SB%3Asbfr=30&sbsbmt=Find+Jobs+%C2%BB&lr=cbc_jobs&cid=US&excrit=QID=A3849808724954%3Bst=A%3Buse=ALL%3BrawWords=work+at+home%3BCID=US%3BSID=%3F%3BTID=0%3BENR=NO%3BDTP=DRNS%3BYDI=YES%3BIND=ALL%3BPDQ=All%3BPDQ=All%3BPAYL=0%3BPAYH=gt120%3BPOY=NO%3BETD=ALL%3BRE=ALL%3BMGT=DC%3BSUP=DC%3BFRE=30%3BCHL=AL%3BQS=SID_CBC_JOBS_QSHOME%3BSS=NO%3BTITL=0%3BRAD=30%3BJQT=RAD%3BJDV=False%3BExpHigh=gt50%3BExpLow=0%3BMaxLowExp=-1&IPath=JRKV
http://www.thingamajob.com/Job-Search-Results.aspx?src=-1&PAGE_NO=1&keyword=data+entry&CATEGORY=&COUNTRY=&STATE=0&ALERT_FLAG=false
http://jobsearch.usajobs.gov/Channels/USAJOBS/search.aspx?q=data%20entry&lid=&jbf571=&salmin=&salmax=&paygrademin=&paygrademax=&FedEmp=N&tm=&vw=d&brd=3876&ss=0&FedPub=Y&submit1.x=98&submit1.y=15&pg=1&re=0
http://hotjobs.yahoo.com/job-search?actualkw=work+at+home&kwchanged=1&kw=data+entry&locations=&industry=&is_loggedin=0&ui_kw=work+at+home
http://www.virtualvocations.com/jobs
http://www.search.computerjobs.com/jresults.aspx?s_kw=work+at+home&s_kw=work+at+home&s_sl=&s_sl=&s_or=order+by+search_priority+desc%2c+search_rank+desc
http://mycareer.com.au/search/?s=155&sq=Data+Entry
http://www.cwjobs.co.uk/JobSearch/Results.aspx?Keywords=data+entry&Radius=5
http://www.jobster.com/find/US/jobs/for/data+entry
http://blog.2work-at-home.com/WordPress/?s=data+entry
http://www.elance.com/php/search/main/eolsearch.php?matchType=project


Assignment Board #2 

 

Assignment Board #3 

 
 

http://www.ifreelance.com/Freelance-Jobs/Data-Entry-Freelance-Jobs/
http://www.odesk.com/jobs/writing-translation/sc/copywriting/

